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Fire fighting procedures at sea and in port

(Nnon3yHoOK no cepeaunHe A0NXKeH NOJHOCTb 3aM0J/IHUTbCA 6e/biM LBETOM, NponagaeT CTpesika BNpaBso)
Danee Haxkumaem “Menu” n nepexogum K cnegyioLuen rnase.

TaK Ke B r/1aBax 4acTo NONaAaloTcA NONaAalTCcA BONPOChl (B KOHLE), Ha KoTopble oTBeyaTtb HE
OBA3ATE/IbHO! Ecnu oHM ecTb, TO CTOMT BbINONAHATb MHCTPYKLUM YKa3aHHbIE Bbille, T.e. TO/IbKO
HaXXUMmaTb CTP/Ie/IKY BNpaso...

[nA ycnewHoro NnpoxoxAeHus Tecta Heob6xoanMMo UTo6bl Kaxkaas rnasa 6bl1a npocMmoTpeHa
Ha 100% u TecT BbINONHEH He MeHee 75% (a TaK 3TOT JOKYMEHT COAEPIKUT BCE BO3MOXKHbIe BaPUaAHTbI
BOMPOCOB, TO NPX NPaBUJIbHO UCNOJIb3OBAaHMU OTBETbI Ha TecT 6yaet 100%).

Mpu BbinonHeHUMU Tecta (“Assesment”), oTmeyaem NpaBuUAbHbIN oTBeT(bl) HaXkumem “Done”.
MNoABnAeTbCA CTPe/IKa BNPABO, HAXKMMeEM €€ U Nepexoaum K c/ieayloemy Bonpocy.

Which of the following must smoke divers be equipped with?

UHF radio

Heat measuring monitors

First Aid kit

Infra-red viewing equipment
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CD # 1 Personal Safety

CocTouT 13 NATU rnas.

1-4 rnaBbl - OTKPbIBAaEM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcs PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

5 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha ogunH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.



1) What s the intention of the Safety Meeting?
1. The intention of this meeting is to gather the off duty crew so that they can get to know each
other better, which will affect the safety onboard.
2. The intention of this meeting is to assign planned work to the crew, and to insure that checklists
and permits have been filled in before the work starts.

4. The intention of this meeting is to discuss the activities ashore.

2) Why is it important that you become familiar with the vessel, the equipment and your own duties
on board as soon as possible?
1. Itisimportant for you to know so that you can find your way around without someone guiding
you all the time.

3. In anemergency situation it is important to know where to find the Safety Officer for reporting.
4. Itis important to know the port operational procedures for handling cargo.

3) Combine the correct hazard sources signs and name.

Combine the correct hazard sources signs and name.

A\

Heating Dﬂ Chemicals %

4) Are you allowed to smoke marijuana when outside U.S water?
1. Yes, you are allowed to smoke marijuana outside U.S. water
2. Yes, you are allowed to smoke marijuana if there are at least 4 hours until you go on duty, and
you have permission from the master.

4. Yes, only for medicinal purpose.



5) Which types of work require permits or check list?(Check all correct answers)
1. Painting on deck

Lowering the anchor

6) Which are the most common injuries in general on board?
1. Toxic injuries
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6. Burns from steam, hot oil or chemicals
Injuries of back or shoulders caused by poor working posture or wrong lifting techniques.

~

7) Which accidents or injuries are the most common connected to maintenance work?
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using the needle gun on a foot

[e)]

swallowing dust

falling overboard

©

8) Place the correct text right of the pyramid (PacctaBnsaem B Takom nopsiake)

F

9) Protection and Environment work consists of which four elements?

2

Jubilees and celebrations

5. Seasickness protection
Looking for oil spills

[e)]

8. Drug testing the crew



10) How can you best protect yourself against the most common injury, sprains or cuts in hands, arms
or fingers?
1. By avoiding operations and jobs that can cause such accidents

3. By never touching anything with your hands and always using some kind of tool
4. It depends on the work requirement.

11) In which type of jobs is there a risk of exposure to harmful substances?




CD # 2 Ship General Safety

CoCcTouT 13 WecTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcs PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAapPMaHTOB OTBETOB.



1)

2)

3)

4)

5)

6)

What is the meaning of the term ‘Vessel Risk Factors’ as described in this module?

2. Only factors which represent a risk of failure of a ship’s machinery.
3. Only factors which represent a risk to the vessels structural strength.
4. Only factors which represent a risk to the health of a ship’s crew.

Select the correct statement: High specific gravity cargo piling up on the tank top may affect the
structure of -

1. the double bottom only.

2. the double bottom and the side shell.

4. the side shell only.

What information should be contained in the 'Vessel Enhanced Survey File?' Select all correct
options.

4. arecord of the weather conditions affecting the deck area and superstructures.

Who is ultimately responsible for the general condition and maintaining the structural strength of a
vessel?
1. Only the Classification Society Surveyor.

3. Both the surveyor and the owner
4. Only the Ship's Master

How should ‘significant defects’, identified during an enhanced survey inspection, be dealt with?

2. They should be added to the vessels dry-dock repair list.
3. They should be given a condition of class and checked again at a later date.
4. They should be repaired at the next convenient opportunity.

The overhaul of an auxiliary engine is to be carried out by an experienced engineer assisted by an
inexperienced junior engineer. Is it important to follow the instructions given in the Planned
Maintenance System manual when work is carried out by an experienced person?

2. Since an experienced engineer is participating, the use of reference information is not
particularly important.

3. If there is time to use reference information, this can be done. Otherwise it is not particularly
important.

4. The Planned Maintenance System manual needs only to be used by the junior engineer.
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7) How do structural corrosion and structural damage affect the risk to the general safety of a vessel?
Select all of the correct options.

3. Increase the risk since still water bending may occur.
4. They have no affect on the level of risk.

8) The vessel structure is subject to stresses due to various internal and external forces acting upon it.
Select, from the options given, the conditions which will result in additional stress due to external
forces.

3. Operation of ship’s machinery
4. Stowed cargo.

9) When considering machinery risk factors, in the context of the vessel risk profile as defined in this
module, which machinery or systems may be considered to be the most critical?

2. The failure of any piece of machinery or system which would result in the vessel being put 'off
hire.'

3. Only the main propulsion system.

4. Only the steering gear and electric power plant.

10) Which factors should be considered when putting together a vessel risk profile as described in this
module?

2. All factors that give a risk of machinery failure.
3. All factors that give a risk of the cargo being damaged.
4. All factors which may result in an increased risk of corrosion.

11) What would be the result of loading a vessel without a properly formulated loading plan,
particularly at a high loading rate terminal? Select all of the correct options.

n

It may create stress raisers.
It may accelerate corrosion of the hull structure.

w

12) How can machinery risk factors which contribute to the vessel risk profile as defined in this module
be limited or eliminated? Select all of the correct options.

3. By only operating on good quality distillate fuel

10



13) Which vessel types are subject to enhanced survey requirements as part of an Enhanced Survey
Programme?

2. Only bulk carriers
3. Only offshore support vessels
4. Only oil tankers

14) An experienced officer is signing on a new vessel. Immediately upon arrival, he is ordered to take
the watch on the bridge without completing a familiarisation programme. Should this be considered
acceptable?

2. Yes. He has experience on a bridge and so doesn't need to do familiarisation for every ship.

3. Yes, if the Officer of the Watch is certified by the Classification Society, he doesn't need a
familiarisation programme.

4. VYes, if the Officer of the Watch is certified by the Flag State authority, he doesn't need a

familiarisation programme.

15) Where is information regarding vessel structural standards likely to be found? Select all of the
correct options.

3. ISM Manual.
4. Marpol 73/78

16) Which publication contains the requirements for testing of ship’s steering gears?

2. Marpol 73/78
3. ISM Code
4. |IMDG Code

17) Which design feature of modern tankers and bulk carriers has resulted in reduced vessel risk factors
as well as improved environmental protection?

2. All aft accommodation
3. All aft machinery spaces.
4. Bulbous bows

18) Which components are considered to be part of the main propulsion system for a vessel with
conventional diesel propulsion? Select all correct options.

3. Electrical power generation and distribution system
4. Steering gear system

11



19) Which personnel should be familiar with the emergency electrical power supply arrangements and
change over procedures?

2. Only the Chief Engineer.
3. Only the ship’s Electrical Officers.
4. Only the watchkeeping engineers.

20) Why is there a greater risk of serious fire hazard in the engine room than anywhere else on the ship?
Select all correct options.

3. Smoking is generally permitted in the engineroom.
4. Engine rooms are always dirty and oily.

21) Which of the following activities is classed as condition monitoring in respect to engineroom
operations? Select all of the correct options.

3. Maintenance based on running hours or service time.
4. Maintenance based on breakdown

22) Which of the following elements are considered necessary for safe and effective voyage planning?
Select all of the correct options.

23) Once a voyage plan is formulated who should sign it to confirm acknowledgement that it is
acceptable?

2. Only the Master.
3. Only the Navigating Officer.
4. Only the Chief officer.

24) Which of the following should be included in a voyage plan? Select all of the correct options.

12



25) he GMDSS equipment is considered essential to the ship’s general safety. Which of the given
options either individually or in combination, is considered an acceptable arrangement under SOLAS

requirements for maintenance of the equipment? Select all of the correct options.

4. The maintenance can be carried out by any of the ship’s engineers.

26) How has the incidence of collision and grounding in congested waterways been significantly
reduced?

2. Introduction of double hull vessels.
3. Introduction of special areas in Marpol regulations.
4. Introduction of marine fuel sulphur limits

13



CD # 4 SOPEP

CocTouT 13 WecTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPpMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

What does the abbreviation SOPEP mean?

2. Shipboard Oil Pollution Emergency Procedures
3. Safety and Oil Pollution Emergency Procedures
4. Safety and Qil Pollution Emergency Plans

Which statement is true?
1. Every vessels of more than 400 gross tons must carry a SOPEP manual.

3. Vessels carrying an IOPP Certificate do not need a SOPEP Manual.
4. Every vessel of more than 400 gross tons must carry a SOPEP manual in the United States
waters.

Are OPA 90 and SOPEP applicable for the same type of vessels?
1. Yes, but OPA 90 is only applicable to the U.S. coast while SOPEP is applicable in all waters.

3. No, OPA 90 is only mandatory for vessels of more than 500 gross tons.
4. No, OPA 90 is only mandatory for tanker vessels.

What is a Risk Profile?

2. ARisk Profile is a risk factor related to your vessel during an oil spill.
3. ARisk Profile is the vessel’s risk factors of any oil spill that may occur.
4. A Risk Profile is a document that must be part of an oil spill initial report

What are the two most important parties to be notified in case of an oil spill in US waters?
1. US Coast Guard National Response Center and the cleaning-up contractors.

3. Cleaning-up contractors and company representative in US.
4. US Coast Guard National Response Center and the company head office.

What agreement is to be entered into between a vessel and a salvage company in an emergency?
1. Vessel Response Plan (VRP)
2. Vessel Emergency Form (VEF)

4. Salvation Open Document (SOD)

What is the most important risk factor to be observed relative to contingency?
1. Lack of ship management training.

3. Inappropriate training of operating personnel in preparedness of safety equipment.
4. Lack of ship crew training.

What is the top priority if an incident occurs in US waters?

2. Protection of the environment
3. Prevention of oil pollution
4. Safety of the cargo

15



9) For which of the following categories is it important that predefined tasks have been established?
1. Senior officers
2. All officers

4. Deck personnel

10) Is it necessary to carry out 'oil spill drills?"'
1. Yes, but only if trading in US waters
2. Should be carried out if not resulting in delay or loss of working hours

4. Yes, but not until a non-conformity is established

11) Who must contact the news media first?
1. The Master is to send out a press release as soon as the vessel and crew are safe.
2. The Company's Managing Director is to issue a press release as soon as he has talked with the
Master.

4. The Master is to send out a press release but only after the approval of the local coast guards

12) What do we call situations that could have led to an accident if they had developed further?
1. Non-conformities
3. Accidents
4. Risk factor

16



CD #5ISM Code

CoCTOMT 13 WecTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogum K
cnenyrouLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

For whom is the ISM-Code mandatory?
1. Allvessels 500 grt and above

2. Alltankers

3. All vessels built after 1998

4. All vessels on International routes

Why is the ISM-Code mandatory?

1. To satisfy US Coast Guard

2.

3. To save money for the company
4. To get lower insurance premiums

The ISM Code is part of?
1 soLAs

2. STCW

3. MARPOL

4. High Speed Craft Code

What does SMS mean?

1. Shipboard Management System
2. Safety Manual System

3. Safety Management System

4. Shipboard Management Safety

Who can contact the Designated Person?

1. The shipping company only
2. The Captain

3. All Senior Officers

4.

The Safety Management System requires that the shipping company develops and implements?

1.
A system for voyage planning

2.
3. A system for main engine maintenance
4. A system for managing unplanned maintenance tasks

Mark the 4 occasions when you should send a report to the DP (Designated Person).

Your salary is not correct.

The chief cook’s food is not good

1
2
3.
4.
5
6

Why should you report accidents to the DP (Designated Person)?

1. To find some one to blame.

2.
3. So the company can calculate your safety bonuses
4. To be able to receive an insurance claim

18



9) Who can suggest changes to the SMS?
1. The designated person
2. The Captain
3. AllOfficers and Crew
4. All Senior Officers

10) Drag the correct work permit to the work situation where you need it.
Drag the correct work permit to the work situation where you need it.

Hat Worl-c g : Worklr‘lg
j Cutboard
Permlt iy | =

_“ —l:""‘": F'errnlt

Enclosed
Space Entry
Pearmit

F as g TR,
Electrical Waorkls
'= Permit
I ! 3
= ;

Small Craft
Alongside

Working Aloft 15
Parmit

Parmit

11) When are you allowed to throw plastic garbage overboard?
1. Being more than 25 miles from shore.
2. Only at night when it’s dark.
3. Being more than 6 miles from shore

4. Nevet

12) How many hours of rest is the minimum required in a normal day?

1. 14 Hours
2. 10 Hours
3. 6 Hours

4. It doesn’t matter as long as my overtime is paid for.

13) Which of the people onboard should have a job description?
1. Captain and Chief Engineer
2. Senior Officers
3. Officers

4. All Onboard

14) Where can you find information about your duties in the event of an emergency?
1. Ask your superior

3. In your employment contract
4. Someone will always tell you, so you don’t need to know.

19



CD # 21 GMDSS

CoCTOMT 13 WeCTn rnas.

1-5 rnaBbl - OTKPbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogum K
cnenyrouLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha ogunH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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What does GMDSS stand for?
1. Global Maritime Distress Surface Search.

3. Global Maritime Disaster Search System.
4. Global Maritime Digital Safety System.

Which operator's certificate gives you the authority to sail on any GMDSS ship in all sea areas?

2. MOC
3. ROC
4. DSC

One of the most important advantages with GMDSS is that...
1. a ship can always communicate via satellite

2. aship can always communicate via radiotelex

3. every ship has the same equipment

Ship-to-ship distress alerting is primarily based on...
1. satellite communications

3. mobile telephones
4. VHF telephony

What does RCC stand for?
1. Research Coordinating Centre

3. Resource Coordinating Centre
4. Retransmitting Coordinating Centre

What does MSI stand for?
1. Maritime Service Information
2. Maritime Surface Information

4. Maritime Security Information

Which equipment on the bridge is used for locating a SART?

2. Radio Direction Finder
3. 10 cm (3 GHz) Radar
4. Radar Direction Finder



8) Which VHF channel shall be used for bridge-to-bridge communications concerning safety of
navigation and manoeuvring in the GMDSS?

1. Channel 08
3. Channel 16
4. Channel 70

9) On which VHF DSC channel shall all GMDSS equipped ships keep watch?
1. Channel 13
2. 2187.5kHz
3. Channel 16

10) Which is the distress and safety frequency for MF DSC?

1. 2182 kHz
3. 8291 kHz
4. 8414.5 kHz

11) What is the coverage of Inmarsat's geostationary satellites?

2. Global including the polar areas.
3. The Atlantic, Indian and Pacific oceans.
4. The Atlantic, Indian and Pacific oceans and the polar areas.

12) What is false regarding the Inmarsat EPIRB?
1. Instant alerting
2. It will be activated if the ship sinks

4. Minimum battery capacity is 48 hours.

13) What is false regarding the COSPAS/SARSAT EPIRB?

2. It will float free and be activated if the ship sinks
3. Global coverage
4. Minimum battery capacity is 48 hours

14) What is the name of the international convention that regulates GMDSS?
1. STCW
3. MMSI
4. GMDSS
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15) You have received the 9-digit MMSI of a ship in distress. In which ITU publication can you find
the name of the ship?
1. List of ship stations
2. List of ship names

4. List of radio determination and special service stations

16) Sea area Al means an area ........

2. within 30 nautical miles from the coast
3. within 150 nautical miles from the coast
4. coastal water in sight of a Coast Station

17) Sea area A2 means an area ........
1. within Radar coverage of at least one Coast Earth Station
2. within 150 nautical miles from the coast
3. coastal water in sight of a Coast Station

18) Sea area A3 means an area ........
1. in one of the three major oceans
2. thatis global
3. thatis further out than 150 nautical miles from the coast

19) Sea area A4 means an area .......

2. with no ordinary radio communications
3. thatis global
4. outside the ordinary ship traffic routes

20) What is the speed of radio waves?
1. Speed of sound
2. 1,000 NM/h
3. 1,000 km/h

21) What is the most important factor for the range of a VHF station?
1. The output power

3. The power supply
4. The size of the antenna
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22) What is the most important factor for the range of an HF station?
1. The output power
2. The height of the antenna

4. The size of the antenna

23) J3E is used for .......
1. distress communications on 2182 kHz
2. VHF telephony

4, TLXradiotelex

24) F1B is used for ........
1. distress communications on 2182 kHz
2. VHF telephony
3. SSBradiotelephony

25) F3E is used for ........
1. distress communications on 2182 kHz

3. SSBradiotelephony
4. TLXradiotelex

26) What is the function of squelch?
1. Automatic gain control
2. Automatic tuning
3. Dual watch

27) Why is channel 16 a simplex channel?

2. ltis cheaper
3. Simplex is less sensitive to interference than duplex
4. Not every country provides duplex service

28) What are the three first digits in a ship's MMSI indicating, for example 265010107?
1. The type and size of the ship

3. The type of communication equipment
4. ltisjust aserial number

29) What is false regarding the ARQ mode in radiotelex?
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1. It practically guarantees error-free data
2. Automatic exchange of identities guarantees connection with the requested station.
3. Communication is possible between only two stations at a time

30) What is false regarding the FEC mode in radiotelex?

2. A message may be transmitted to several receiving stations simultaneously
3. It does not require transmitters at the receiving stations
4. You do not need to know the selcall of the receiving station

31) How must a satellite antenna be mounted for approval in the GMDSS?
1. As near the transmitter as possible
2. As high as possible

4. Midships

32) Why shall the SART be mounted as high as possible in the survival craft?
1. To protect the SART from sea spray
2. The flashlight shall be easily discovered by a rescuer
3. To protect the people in the survival craft from radiation

33) For how long time should an EPIRB be able to operate on its batteries?
1. 36 hours
2. 24 hours

4, 96 hours

34) Vessels operating in which sea area(s) are required to carry either INMARSAT or HF equipment
or a combination thereof under GMDSS?

2. Allsea areas
3. A4
4, A3 and A4
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CD # 22 Maritime English, Ship Familiarisation
COCTOWUT U3 LLIECTU rnaB..

1-5 rnaBbl - OTKpbIBaeM KaxKayto, Haxknumaem NEXT (cTpenka BnpaBo), 40 TOro Noka OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogum K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPpMaHTOB OTBETOB.
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1) Look at the image and choose what it indicates ?

1

2. Bulk carrier

3. Container ship
4. Passenger ship

2) Look at the image and choose what it indicates?

1. Poop deck
2. Bulbous bow
3. Rudder
4. Porthole
3) Choose the correct option RoRo?
1. Ride on ride out

2. Rhumbline on river ornico
3. Roll out roll over

4. Roll on roll off

4) Choose the correct option ETA?
1.
2. Extra terrestrial alien
3. Extra time allowance
4. Estimated time of anchoring
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5) Which of the following is the correct abbreviations for two most common standard sizes of
containers?
1. TPCand FTC
2. TEU and FEU
3. DWTand FWA
4. TFT and FFT

6) What is the most common name for ships, which carry oil in bulk?
1. General cargo ships
2. RoRo
3. Ferries

4. Product tankers

7) Who has the overall responsibility of the engine room and its maintenance?
1. First Engineer
2. Second Engineer
3. Master

4. Chief Engineer

8) SAFETY Onboard is to ensure that all work procedures and operations are planned keeping in mind
the following:

12) Which IMO Convention deals exclusively with the Environmental Pollution?

1. ISM

2. MARPOL
3. STCW
4. SOLAS

13) What is the most widely used general emergency alarm onboard ships?
1. Signal of one short blast, one long blast repeated seven times
2. Signal of seven short blasts, followed by one long blast
3. Signal of seven long blasts followed by one short blast
4. Signal of three long blasts

14) What should you do when you hear a General Emergency Alarm?
1. Contact bridge
2. Evacuate the premises
3. Shout Fire

4. Proceed to your designated muster station

15) Which is the recommended colour of the Foam Type Fire Extinguishers?

L. Yellow

2. Blue

3. Black
4, Red

16) Where on ship would you find a Fire Blanket?
1. Bridge.
Engine control room

2.
3. Galley
4

Radio room
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17) When a man falls overboard, which of the following is not the required immediate action?
1. Shouting 'man overboard'
2. Throwing a lifebuoy
3. Sounding general alarm
4

18) When a man falls overboard, we should immediately throw the nearest lifebuoy overboard. Is the
statement correct?

1. e

2. False

19) Choose the correct option.In ABC of first aid, A stands for

1. Always
2. Alleways
3. HifWay
4. Arteries
20) Choose the correct option.In ABC of First Aid, B stands for
1.
2. Breastline
3. Bandage
4. Bleeding
5.

21) Which list details the duties and responsibilities in case of emergency onboard? The statement is:
1. Muster list
2.
3. Daily work list
4. Hot work checklist
5.

22) Choose the correct option.0SC stands for
1. On ship captain

Over ship commander

2
3.
4. On scene commander

23) Which Publication gives detailed guidelines about conduct of various parties during Search and

Rescue?
1. IAMSAR Manual
2. IMO SAR Manual
3. SOLAS
4. MARPOL
5.
24) What is the Maximum possible Latitude?
1. 90 degrees north

2. 180 degrees north
3. 270 degrees north
4. 360 degrees north

25) What is the Maximum possible Longitude?
1. 90 degrees east

2.
3. 70 degrees east
4. 360 degrees east
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26) What is the primary function of echo sounder?
1.
2. To provide speed of ship
3. To provide course of ship
4. To provide position of ship

27) Safe speed is defined as that speed where
1. Vessel can be stopped within range of visibility
2. Vessel is navigating at slower speed than vessels around
3.
4. Vessel is proceeding at manoeuvring speed

28) Any action taken to avoid collision shall

29) This picture represents a power driven vessel more than 50 meters in length underway. Drag and
drop the correct image for various lights shown here.

-

[Masthead ||gh5

J'*' ;

Port Side Starbeoard
lights Side lights

g

O

|: Stern light ﬁ
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30) Look carefully at the navigational lights shown by this vessel and click on the right option what these
lights indicate.

Vessel aground

Vessel not under command
Vessel restricted in her ability to manoeuver

el

31) Here is the image of four cardinal marks on one side. Match the light characteristics associated with
each type of buoy.

[== 5

A

F'y

[2%5™ T
=)

-

e
(3]

Q (6) + LFl or &
vg (8] = LFI

-

32) To indicate a new danger, a duplicate mark is provided besides the normal original mark. Is the
statement correct?

1. firue

2. False

33) Is the statement correct? The sheet bend is used to join two ropes of different size together.

1. e

2. False

34) Is the statement correct? Reef Knot is used to tie two ropes of equal size or thickness together.

1. e

2. False

35) Which is the correct type of stopper to be used for wire ropes?
1. Rope Stopper
2.
3. Wire Stopper
4. Nylon Stopper
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36) Select the most appropriate phrase to indicate that eye of first mooring line has been laid around
the bollard on jetty?
1. Mooring on jetty
2. First fast
3. First line ashore
4

All fast

37) Drag and drop on to the image

! __

Forvard s
Springs | =

1 Forward .
Breast Lines

Aft Breast
Lines

fe correct match. This one is.

38) Identify the flag and its meaning.

A “ ALFA; | have a diver down; keep well clear at slow speed.

D “ DELTA; Keep clear of me; | am manoeuvring with difficulty.
E “ ECHO; | am altering my course to starboard.

PwNPR
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39) What is the meaning of Flag Hotel depicted above.

PwnNE

I am in process of embarking a pilot.
| have a pilot onboard.
Identification signal given by ship to pilot boat.
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CD # 30 Marine Lubricants

CoCcTOMT 13 WecCTn rnas.

B 3TOM TecTe Heo6X0AMMO OTBEUATb Ha BOMPOCHI MPAMO a raBax. OTBETbI Ha BCe BOMPOCH! BEIAEACHHBI
STUMILBETOM. Ha oavH BONPOC BO3MOXHEH OAMH BapWaHT oTBeTa.
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Subject 1
1) Lubricant base oils generally
1. 300 degrees Cxt
2. 200 degrees C.
3. 150 degrees C.
4. 100 degrees C.

2) Crude oils are roughly classified as:
1.
2. straight and branched chain
3. waxy and asphaltic
4. heavy and light.

3) The refined lubricant base oil properties are greatly influenced by
1. storage and treatment
2. refining process
3. chemical treatment
4.

4) Solvent extraction is a:
1. vacuum distillation process

2
3. atmospheric distillation process
4. hybrid process.

Subject 2

1) Whatis EP (Extreme Pressure) oil?
1.
2. High pressure hydraulic oil
3. Standard gear oil
4. High maximum pressure cylinder oil.

2) Base oil combinations are selected to meet:
1. pour point
viscosity index

2.
3.
4. oxidation stability.
3) Oxidation inhibitors are:
1. removing oxygen from the oil
2. dissolving oxygen in the oil

3. preventing rust
4.

4) Friction modifiers or "oiliness additives" will:
1. improve the viscosity index

2
3. increase the pour point
4. extend lubricating oil life time



Subject 3 — Bonpcos Het

Subject 4
1) What is mixed lubrication?
1.
2. When using grease and lubricating oil together
3. When mixing mineral and syntetic oils
4. When changing type of lubricating oil from time to time

2) What is elastohydrodynamic lubrication?
1. A combination of different lubricating oils.
2. | An additive to keep the viscosity index stable under various conditions.
3. The contacting surfaces are elastically deformed, distributing the load over a greater area.
4. | Water is added to the oil because it is not compressible and we can increase the load.
3) Why should "EP" additives only be used on ferrous metal surfaces?
1. Will be chemically bound to other metals
2. Will change viscosity
3.
4. Will change chemical composition.

4) What is the main criterion for fluid hydrodynamic conditions?

1. Viscosity
2. Anti-wear agents
3. Flow of lubricant
4. Temperature of bearing.

Subject 5

Applications

Please click the illustrations to learn more about the subjects!

& Marine Lube Oil Applications [~ I I <}=-| —bl Menu I Exit

Ona BbinonHeHua Tecta Ha 100% He06X0AMMO HaXKaTb Ha KaxKa0e n3obparkeHne U HaXKMmarb
CTpenKy Aasiee NOKa onATb He NOABUTbCA 3TO U3obpakeHue. Korga Bce 6 NpoitgeHbl, HAaXKUMaem
CTpenky Aanee u BbinonHsaem tect!!!

1) Whatis the "NLGI" number of a grease indicating?
1. How water resistant the grease is
2. How fluid or non-fluid the grease is
3. The grease compatibility
4. The grease expected life time.
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2)

3)

4)

5)

6)

7)

In which type of equipment is low pour point and good wax depositing important?
1.

2. Deck winches

3. Medium speed trunk engines

4. Hydrolic cranes.

What is the single most important element for gear oils?
1. Shear stability

2. Anti wear performance

3. Corrosion prevention

2 Viscosity

What is typical BN level for a trunk piston engine operating on residual fuel oil?
1. BN70-BN100

2. BN30-BN40

3. BN 40-BN50

4. BN5-BN10

What is the most important property of a lubricating oil for reciprocating air compressors?
1. Good anti-wear property

2. High viscosity index

3.

Good corrosion protection

What is a typical BN level for a two stroke engine cylinder oil?

1.

2. BN10-BN20
3. BN50-BN70
4. BN5-BN10

Subject 6 — HeTy BonpocoB

37



CD # 36 Medical First Aid

CocTouT M3 OAMHHAALATM [NaB.

1-10 rnaBbl - OTKpbIBaEM Kaxkayto, Haxknmaem NEXT (cTpenika Bnpago), A0 TOro Noka oHa He NPonaaerT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnepyroLLen rnase.

11 rnaBa — Tect. OTBETHI Ha BCE BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB. Konwnyectso BOMPOCOB Ha KOTOPble Haao OTBETUTb — 40.
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1) One of the main tasks of the blood is to transport oxygen to body’s cells.

2. False

2) Oxygen is transported to the cells by blood vessels called veins.
1. True

3) We have 3 circulatory systems for blood transportation.

NoE
_|
5
c
®

4) The red blood cells are responsible for the transportation of oxygen.

2. False

5) Breathing is controlled by the respiratory centre in the brain.

2. False

w

6) Inspiration is mainly caused by muscle activity of the Diaphragm.

1. e

2. False

7) The respiration system, above all, reacts to carbon dioxide levels in the blood.

2. False
8) A large dose of muscle relaxing medicaments can cause respiratory problems due to the reduced
activity in the respiratory muscles.

1. e

2. False

9) A patient who is shouting has an open airway.

1. e

2. False

10) A sudden fall in blood pressure does not normally lead to circulation failure.
1. True

. e

11) Cardiac arrest leads to circulation failure.

1. i

2. False

12) A limb with an external bleeding should be lowered to maintain circulation in order to supply the
cells with oxygen and prevent cell death.
1. True

2. False

13) A patient who breathes will always have a pulse rate?

1. e

2. False



14) Normal resting rate of pulse in a healthy adult is about 2-3 beats per second.
1. True

2. 8

15) Respiration while resting is normal if the frequency increases to more than 20 ventilations per
minute.
1. True

2. g

16) Cardiac arrest will always lead to unconsciousness.

1. e

2. False
3.

17) When performing C-P-R it is advisable to elevate the patient’s legs to secure sufficient blood to the
chest and head.

2. False

18) You should terminate resuscitation after 15 minutes.
1. True

. e

19) Abdominal thrust is applied to remove foreign objects in the airway.

1. e

2. False

20) The walls in the blood vessels are completely resistant to diffusion.
1. True

. e

21) Aninternal abdominal bleeding is not dangerous as it will stop bleeding by itself due to the
increased pressure in the abdomen.
1. True

2. 8

22) If you are unable to give a patient with an increased circulation failure due to bleeding, intravenous
treatment, he should promptly be given plenty to drink to replace lost fluid.
1. True

2. g

23) Most adults will endure a loss of blood of 1 litre.

2. False

24) Internal bleeding will never lead to circulation failure.
1. True

2. False

25) Bleeding will always occur together with a fracture that breaks the skin.

2. False
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26) Shock and circulation failure are equivalent.

2. False

27) To render correct first aid one should be certain that there is a fracture before treating the patient.
1. True

o

28) There are at least four distinct signs of fracture.

2. False

29) The main goal of splinting is to render a pulling strain on the fractured bone ends, in order to
prevent them from touching each other.
1. True

2. False

30) Cooling does not reduce pain in a sprain.
1. True

2. g

31) The motor function and circulation distal to the fracture should always be assessed.

2. False

32) R-I-C-E treatment has no effect if postponed more than 4 hours after the injury took place.
1. True

2. g

33) Visible shortening of a limb is not necessarily a sign of a fracture.
1. True

o

34) A good splint should prevent adequate blood circulation and compress nerves so the casualty will
not feel any pain.
1. True

. e

35) It may be difficult to tell if there is a fracture or a sprain.

1. e

2. False

36) Head injury will lead to circulation failure.
1. True

2. g

37) Damage to the spinal cord will always result in immediate neurological malfunction.

1. g

2. False

38) A haematoma can be caused by head injury.

2. False
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39) It is the increased pressure in the head that is fatal, not the bleeding itself.

2. False
40) Symptoms of serious head injury are unconsciousness, low pulse rate and high blood pressure.
2. False

41) A spine/neck injury will always have priority over every other injury due to the risk of paralysis.
1. True

2. 8

42) An unconscious patient suffering from a major spine injury should not be placed in recovery position
as this may increase the damage and lead to paralysis.
1. True

2. False

43) A person suffering from a moderate to hard blow to the head should always be under close
observation in the early hours after the accident, considering possible development of edeme in the
head.

1. i

2. False

44) A fractured spine will always imply unconsciousness
1. True

. e

45) When treating an injury obtained by falling, it is of great importance to check the motor function in
the extremities.

2. False

46) Your aims are to maintain the airway, breathing and circulation, to remove any contaminated
clothing, to identify the poison and to obtain medical aid.
1.
2. False

47) Spillage of corrosive chemicals is poisonous and can also result in burns.
2. False

48) Flush away any residual chemical on the skin with plenty of cold water. Be sure that the water does
not flush away from the casualty’s body.
1. True

2. g

49) When an ambulance or more qualified personnel arrives at the scene, there is no need to tell them
about the poisonous chemicals inhaled since they will find out themselves.

2. False
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50) Food poisoning may be caused by eating food that is contaminated by bacteria or by toxins
produced by bacteria that were already in the food.

2. False

51) When we deal with food poisoning your aims are to encourage the casualty to rest, to seek medical
advice or aid, and to give the casualty plenty of bland fluids to drink.

2. False

52) There is nothing more you can do to prevent food poisoning, than ensure that frozen poultry and
meat are fully defrosted before it is cooked. Cook meat, poultry, fish, and eggs thoughly to kill
harmful bacteria. Never keep food lukewarm for long periods; bacteria can multiply without obvious
signs of spoilage.

1. True

2. [l
3.

53) You should always wash your hands before preparing food. Wear protective gloves or waterproof
plasters if you have cuts on your hands.

2. False
54) Oxygen treatment is most important with injury to the head/neck/spine.
2. False

55) You should not supply oxygen when resuscitating, as this will only disturb the treatment. Itis
however important to do so immediately after the resuscitation has ended.
1. True

2. [l
3.
56) Grease and oil must never be used in connection with oxygen bottles, couplings and valves.

2. False

57) All fires will burn easier and faster in an oxygen-rich environment. Therefore, do not use oxygen
bottles near an open fire. Smoking is not allowed.

2. False

58) You should only use double nose catheters when treating two patients on one oxygen bottle.
1. True

. e

59) Oxygen bottles should be handled with care and should be removed if they are exposed to heat.

2. False

60) The respiration system of a person suffering from flame burns is very exposed to damage.

2. False
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61) To protect a burn injury we should never remove the patients clothing.
1. True

2. 8

62) A chemical burn from fluid must be bandaged firmly to prevent fluid from covering greater parts of
the skin.
1. True

2. 8

63) Cooling of a third degree burn should be terminated after 15 minutes.
1. True

. e

64) A patient with a major burn is liable to develop circulation failure.
2. False

65) A casualty with burns has less need for fluid.
1. True

2. o8

66) When there is an electrical burn there is a great danger of internal injuries.

2. False

67) The position and direction of entry and exit wounds will alert you to the likely extent of hidden
injury, and to the degree of shock that may ensue.

2. False
68) A person under influence of alcohol will suffer from frost injuries quicker than a sober person.

2. False

69) A seriously hypothermic patient should as soon as possible be placed in a warm bath (&gt;502C) to
regain normal body heat.
1. True

2. False
3.

70) Moderate and deep hypothermia cause very unstable condition, and the patient must be
inactivated and treated very carefully.

2. False
71) The brain of hypothermic patients will consume less oxygen than usual.

2. False

72) If a patient has heat exhaustion, the symptoms are weakness, vertigo, headache and nausea. Initially
the skin is cool and clammy.

2. False
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73) You can threat a person with heat exhaustion by giving him salt and water.

2. False

74) Heat cramps seldom occurs after excessive sweating precipitated by strenuous exercise.
1. True

. e

75) Heat-stroke can occur suddenly, causing unconsciousness within minutes. This may be signalled by
the casualty feeling uneasy and ill

2. False

76) When dealing with a heat stroke your aims are to lower the casualty’s body temperature as quickly
as possible, and to arrange removal of the casualty to hospital. Do NOT use iced water as they may
constrict blood vessels.

2. False

77) What is the most serious damage to the tissue concerning damage by pressure?
1. Pain and discolouring
2. Dirtinthe wound

3. Increasing pressure and developing oedema.

78) What is the most important treatment concerning a foreign body in the eye?

2. Local anaesthetic
3. Wring the eye-lid to prevent blinking

79) If there are signs of tendon damage, the tendon must be sutured by a surgeon before
1. closing the wound. If so, put on a dressing until qualified treatment can be administered.

3. False

80) Any major bleeding must be stopped before treating a wound.

1. g

2. False

81) None of the tissue cells will die, only damaged when the casualty has a crush injury.

1. e

2. False

82) Do not touch anything that is sticking to, or embedded in, the eyeball, or over the
1. coloured part of the eye, when treating a person with a foreign body in the eye.

2. 8

3. False

83) A bandage is always applied to an open wound.
1. True

2. 8

84) Dressings should always be larger than the wound they cover.

1. e

2. False
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85) Bandages must be sterile before use.
1. True

2. o8

86) A triangular bandage is always used in its triangular shape.

1. True

. e

87) Once a bandage is in place it should be left alone.
1. True

2. g

88) Parts of the body can be used as splints.

1. e

2. False

89) Open weave roller bandages are used to support joints
1. True

2. False

90) Improvised splints can only be made of solid materials.
1. True

. e
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CD # 50 ARPA

Coctout 13 AEBATU TNaB..

1-8 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

9 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha ogunH BONPOC BO3MOXHO

HECKOJ/IbKO BapPpMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

The plotting process can be divided into four separate operations, which?
2. Detection - Selection - Observation - Tracking

3. Selection - Observation - Plotting - Detection

4. Observation - Plotting - Tracking - Cancellation

What does the target ship's aspect mean?

2. The true bearing of target ship measured at own ship

3. The relative bearing of the target ship measured at own ship

4. The true bearing of own ship measured at the target ship

What information is immediately apparent from the "true plot" of another vessel?
2. CPA

3. TCPA

4. Own ships course and speed

What information is immediately apparent from the "relative plot" of another vessel?

2. TCPA
3. Targets true course and speed
4. Own ships course over ground

Which sensor input is required for the ARPA to be able to calculate and display true vectors?

2. None
3. Course
4. Speed

What do the sides in the relative plotting triangle represent?

2. Targets true course - Own ship true course - Targets relative course
3. Targets true speed - Own ship true speed - Targets relative speed
4. Targets true course and speed - Own ship relative course and speed - Targets relative course

and speed

How can true vectors be easily identified as the vectors on display?

2. Own ship has no vector
3. CPA and TCPA limits are broken and alarm is activated
4. The vectors are the same direction as history dots

How can the true course and speed of a target be found when the display is showing relative
vectors?

2. By comparing target vector with own ships vector
3. Can only be found by changing to true vectors
4. By examining the vectors displayed
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9) What does manual acquisition mean?

2. The operator selects an area of interest and targets inside the area are acquired
3. The operator must repeatedly place the cursor on each target and press “acquire”
4. The operator selects the limits of CPA and TCPA and targets breaking these limits are

automatically acquired

10) Comparing manual and automatic acquisition, which is most sensitive?

2. Automatic acquisition
3. Same sensitivity
4. Not relevant

11) Why at different times is there a change in the size of the tracking gate?

2. Target swop has occurred
3. The gate is continually changing
4. The tracking gate size is always the same

12) What is the purpose of digitising the radar echoes?

2. No special purpose
3. Increase accuracy of system
4. Reduce number of radar echoes

13) What is the result of “Target Swop”?

2. A target will no longer be visible on the screen
3. The operator can swap over vectors between ships
4. A target has lost its vector and activates the lost target alarm

14) What is the result if there is no heading input to the radar?

2. The North-Up presentation will still be available
3. An un-stabilised Course-Up presentation will be the only available mode
4. A stabilised Head-Up presentation will be the only option

15) What does the lost target alarm tell you?

2. A previously tracked target has moved out of range and is no longer tracked
3. Radar failure
4. To many targets are tracked

16) What is the purpose of a Guard ring on an ARPA?

2. It avoids the need to continually monitor the radar display
3. It alarms to operator of a close CPA
4. It provides warning of another target on the screen
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17) Which ARPA presentation provides the information “closest to what you see through the bridge
windows?

2. Relative Motion, North Up, Relative vector
3. True Motion, North Up, True Vector
4. True Motion, Course Up, Relative Vector

18) What is the correct speed input to an ARPA used for traffic surveillance?

2. Speed over ground
3. Speed from GPS
4. Speed from doppler log

19) Does incorrect speed input affect the true vectors on an ARPA display?

2. No
3. Onlyallittle
4. Only if the inputis speed over ground

20) If the input gyro course is in error and fed to the ARPA, what can be expected?

2. No problem
3. Error in other ships speed only
4. Error in other ships course only

21) Does current and drift affect the CPA/TCPA calculations on a true motion, true vector presentation?

2. Yes
3. Only a little bit
4. Yes, very seriously

22) What influence does an error in speed and/or gyro input have on the calculated CPA and TCPA?

2. The CPA will be wrong but TCPA will be correct
3. The TCPA will be wrong but CPA will be correct
4. Both CPA and TCPA will be wrong

23) To which condition of visibility does Rule no. 5, Lookout, apply?

2. Restricted visibility only
3. Night-time only
4. Good visibility at day-time

24) You have radars installed on your ship, are you required to use them?

2. No
3. Only at night-time
4. Onlyin restricted visibility
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25) Ship Ais navigating in an area of restricted visibility and has detected, by radar alone, a crossing
ship, B, on her port bow. Which ship is the "Stand-On" vessel?

2. ShipA
3. ShipB
4. Ship A, as long the ARPA clearly shows that ship B is crossing from port

26) What is the meaning of this symbol?

2. The target has been automatically acquired and is in acquisition state
3. Dangerous target
4. Lost target

27) What is the meaning of this symbol?

2. Lost target
3. Acquired target
4. Selected target

28) What is the meaning of this symbol?

2. Dangerous target
3. Auto acquired target
4. Manual acquired target



CD # 53 HAZMAT - IMDG Code

CocTouT U3 oAMHa4LATU [NaB.

1-9,11 rnaBbl - OTKPbIBAaEM Kaxkayto, Haxkumaem NEXT (cTpesnka BNpaBo), 40 TOrO NOKa OHa He nponageT
n He noasuTbca PREVIOUS (cTpenka BneBo) M KHonka MENU. Haxknumaem MENU, nepexoanm K
cneaywoulen rnase.

10 rnaBa — tect. OTBETHI Ha BCE BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1) Which of the following types of packaging are covered by the general term “cargo transport unit”?
(Select all applicable answers)
1.

ok wnN

7. Large packagings.
8. Inner packagings.

2) Which group of dangerous goods is generally understood to be the most hazardous for marine
transportation?

Toxic gases.
Infectious substances.
Flammable liquids.
Oxydizing substances.

ukhwnN e

3) According to the IMDG Code, a freight container which is loaded with dangerous goods and which is
intended for transport by sea, must display the placards as described by which of the following

statements?

1. On each side and on each end of the container.

2. On each side and on the back end of the container.

3. On each side only.

4. On the back end only.

5. On each side, each end and transversely in the middle of the top of the container.

4) Which of the following are contained in the Supplement to the IMDG Code? (Select all applicable
answers)

4. The Dangerous Goods List.
5. The List of Generic and N.O.S. Proper Shipping Names.

5) Which of the following abbreviations is used to denote a Marine Pollutant in the Dangerous Goods
List?

P

6) Which of the following is a correct statement?

e e st e e

2. Substances in the surrounding environment can have no dangerous impact on packaged
dangerous goods.

3. A dangerous reaction between a substance or article and other substances in the surrounding
environment is only possible if those goods are packaged in a container constructed of soft and
non water-resistant material.



7) Which Packing Group is assigned to substances presenting a low level of danger?
1. Packing Group I.
2. Packing Group .

3. Packing Group IIl

8) Which of these is the UN Packaging Symbol? (Drag &amp; drop the correct symbol into the box.)

1.

9) What is salvage packaging?
1.

2. Packaging used only at the direction of a contracted environmental protection response

company.

Packaging which has been reconditioned after previous use.

Packaging which is manufactured from recycled material.

5. Packaging in which goods recovered from the sea are held, pending investigation by the
appropriate authority.

W

10) Which of the following are considered a “Cargo Transport Unit” under the IMDG Code? (Select all
applicable answers)

3
4
5.
6.
7. Military personnel vehicles.

8. Large plastic barrels of 150 litres or more.

11) Within the IMDG Code, the term “labelling” refers to which of the following?
1. Identification of the risks and hazards presented by substances contained in a package.
2. ldentification of the substance contained in a package.
3. lIdentification of the risks and hazards presented by substances contained in cargo transport
units.

12) Within the IMDG Code, the term “marking” refers to which of the following?
1.
2. ldentification of the risks and hazards presented by substances contained in a package.
3. lIdentification of the risks and hazards presented by substances contained in cargo transport
units.

13) A ”"Consignee” is which of the following?
L. Any person, organization or Government that is entitled to take delivery of a consignment.
2. Any person who prepares a shipment for transport.
3. A shipment of dangerous goods.
4. A member of a competent authority charged with the administration of the transportation of
dangerous goods.



14) Proper Shipping Names and UN Numbers are used for which two primary purposes?

3. To complete the additional security documents when entering a port subject to a level “orange”

security alert.
4. To demonstrate compliance with MARPOL 73/78 when subject of a Port State Inspection.

15) Which of these packing labels is used to indicate a Marine Pollutant?

Tt

o

1.

16) The Medical First Aid Guide for Use in Accidents Involving Dangerous Goods provides advice
intended for what?
1.

2. The comprehensive and total management of chemical poisoning and diagnosis to full recovery,
with assistance from shore as required.

3. The proper documentation to the flag state authority in the event of a fatality involving
dangerous goods on a vessel.

4. The limited care of casualties in exposure incidents involving liquid chemicals.

5. The accurate transfer of information relating to a spilled cargo to the appropriate shoreside
medical and environmental agencies.

17) Which organization today is responsible for maintaining the IMDG Code?
1.
2. The International Hazardous Goods Committee.
3. The MARPOL 73/78 Advisory Committee.
4. The Governments of different countries.

18) Where do you find the Dangerous Goods List?
1. Volume 1 of the IMDG Code.
2. Volume 2 of the IMDG Code.
3. The Supplement to the IMDG Code.
4. MARPOL Annex I

19) What does the abbreviation “IBC” stand for?

L. Intermediate Bulk Container.

2. Industrial Bulk Container.
3. Internal Bulk Construction.
4. International Booking Code.

20) Whatis a “UN Number”?

L. A unique identifying number assigned to a dangerous substance, material or article.

2. An unique international code assigned to a vessel authorized for the carriage of dangerous
goods in packaged form.
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3. An emergency contact number for use in the event of an injury or pollution incident involving a
dangerous substance as listed in the Dangerous Goods List in the IMDG Code.

21) What does an EmS number refer to?

e o Snpagng g Goom S

2. The emergency response procedures as outlined in 46 CFR 32 of the US Federal Code of
Regulations and expanded in the USCG Guidelines on the Transportation of Dangerous Goods by
Sea.

3. The relevant guidelines listed in the Anti-Pollution chapter in MARPOL.

22) What are the three states of matter used in the IMDG Code? (Select all applicable answers)

2.

3.

4. Moisture.
5. Frozen.

6. Atmospheric.

23) When the UN Committee drew up the different classes of hazardous substances, what did they base
the classification on?

1. The type of hazard they present.
2. Alphabetical order.

3. UN Numbers.

4. Llaboratory tests.

5.

The number of packages of different types of dangerous goods.

24) How many Classes of Dangerous Goods are there in the IMDG Code?

2. 6.
3. 5.
4. 10.
5. 12.

25) Which of these statements defines a “Marine Pollutant”?

1. A substance which s subject to the provisions of Annex il of MARPOL.

2. A substance which, because of its tendency to degrade in seafood, or because of its low hazard
potential to the aquatic environment is subject to the provisions of SOLAS and transported
accordingly.

3. A substance which requires the highest form of protection during transportation and is
regulated accordingly by the International Transportation Authority.

26) Packagings must be so designed that they do not lose their contents through which of the following
specific ways?

5
6. Being turned upside down.

7. Damage through a side impact resulting in puncturing of the outer lining of the packaging only.
8. Excessive adjacent heat resulting in melting of the lining.

27) What special mark must a recycled packaging have on it?
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CAUTION I RECYCLED PACKAGING.
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28) Packagings in direct contact with dangerous goods must exhibit which of the following
characteristics? (Select all applicable answers)

2.
3.
4.

They must be constructed of plastic.
They will not go out of shape as a result of such contact.

29) If you discover a leaking tank container on the weather deck, which of the following actions should

you take?

1. Report it immediately to the Duty Officer.

2. Wash it away immediately.

3. Examine the tank container and try and close off any leaking valves.

4. Make sure the Chief Officer knows about it before arrival, so that no other vehicles drive

through the spillage.

30) What do the letters IMDG stand for in the term IMDG Code?

1.

uhwbn

International Marine Distribution Guild.
Intercontinental Maritime Definition Guide.
Intermodular Material Demographic Graph.
International Marine Danger Group.

31) Which two types of emergency are specifically covered by the schedules in the EmS Guide? (Select
all applicable answers)

2.
3.
4.
5.

Medical emergencies.
Atmospheric pollution.
Oceanic contamination.

32) The classes of chemicals in the IMDG Code are based on which of the following?

1.

uhwbn

o

Alphabetical order.

UN Number.

Laboratory tests of different chemical groups.

The average tonnage of different groups of dangerous substances shipped worldwide in
packaged form.

Airline rules.

33) Which of these symbols must appear on packaging containing radioactive substances? (Drag and
drop the correct symbol into the box.)
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34) Which of the following symbols would you expect to find on a thermal tank containing liquid of a
high temperature? (Drag and drop the correct symbol into the box.)

35) Which of these labels would be attached to a package containing explosives? (Drag &amp; drop the
correct symbol into the box.)

58



CD # 64 Electronic Chart Display

CocTtouT 13 cemu rnas.

1-6 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro Noka OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogum K
cnenyroLLen rnase.

7 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

What is the name of the international standard for exchange of maritime digital electronic chart
information?

1. S-52
2. S-75
4. S-84

ECDIS is an abbreviation for?

2. Electronic Chart Display System
3. Electronic Chart Display
4. Electronic Chart Data System

What is the number of the IMO resolution concerning ECDIS?

2. IMOres. A572(14)
3. IMOres. A 827(19)
4. IMOres. A728(17)

HMI is an abbreviation for?
1. Hydrographic Maritime Institute

3. High Maritime Intelligence
4. Human Maritime Interference

A chart made by using the Lambert projection can be considered to present?

2. Correct angles
3. Correct area and angles
4. None of the above answers are correct

Chart projections are classified according to the type of projection surface used. How many
commonly used surfaces are there?

1. 1

2. 2

4. 4

A geoid refers to?

1. A theoretical model of the earth’s surface

2. A mathematical model of the earth’s surface
3. A satellite derived model of the earth’s surface
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8) How is an ellipsoid formed?

2. By rotating an ellipse about its larger axis
3. By moving a circle about its north/south axis
4. By moving a circle about its east/west axis

9) The “flattening” of the earth is approximately?

1. 0
3. 1/400
4. 1/900

10) The surface of an ellipsoid is?
1. Uneven
3. Regular in direction N/S
4. Regular in direction E/W

11) The first satellite datum was based on:
1. Russian Glonass
2. American GPS

4. American DGPS

12) The worlds first satellite based datum was named?

1. WGS
3. WGS-84
4. GGS-72

13) What is the reference datum for GPS?

1. WGS
2. WGS-72
4. GGS-72

14) In worst case, how much can the difference be expected to be between local datum and satellite
datum?
1. Up to 100 metres
2. Up to 500 metres
3. Upto 1000 metres



15) What is the main element of geographical data?

2. Description of objects
3. Geometric data
4. Hydrographic data

16) Where can you find information about standard terms used in connection with electronic charts?
1. IMO resolution A.472 (XII)
2. IMO resolution A.572 (14)

4. [HO resolution A.888 (21)

17) What is the definition of an Electronic Navigation Chart (ENC)?

2. ENCis a subset of ECDIS
3. ENCis a subset of ECS
4. ENC s a subset of RCDS

18) What is a raster chart?
1. Arraster chartis a chart made by giving digital values to each and every object on the chart
2. Araster chartis a chart made by giving analogue values to each and every object on the chart

4. A raster chart is a computerised chart

19) Which of the following chart is considered “intelligent”?
1. The paper chart

3. The raster chart
4. The computerised chart

20) The accuracy of data on a raster chart is exactly the same as?

2. The computerised chart
3. The Mercator chart
4. The Transverse Mercator Chart

21) What is the worst known difference between a local datum and WGS84?
1. 1NM
2. 3NM
3. 5NM
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22) According to IMO, what type of charts should be used on ECDIS?
1. A computerised chart
2. Arraster chart

4. A scanned paper chart

23) What is the IMO definition of ECDIS?
1. A system which provides information based on GPS.
2. A system which provides information based on all available data.

4. The display equipment used to display ENC

24) An ECDIS consists of?

2. ENCand GPS
3. ENCand RCDS
4. RCDS and GPS

25) ECS is a system that?

2. Meets SOLAS requirements
3.  Will meet SOLAS requirements after Y-2000
4. Uses radar information

26) A raster chartis a chart that is?
1. Only usedin a RCDS
2. Only used in a ECDIS

4. Only used together with paper charts

27) Can a raster chart be displayed in head-up mode on today's ECDIS?
1. Yes

3. Only during route planning
4. Only charts with small scale

28) Vector charts can?
1. Only be displayed with North up
2. Only be displayed Head up
3. Only be displayed Course up



29) Can raster charts be “customised”?
1. Yes
3. Only when used on an ECDIS
4. Only when used on a RCDS

30) Can raster charts provide navigational warnings?
1. Yes
3. Only when used on an ECDIS
4. Only when used on a RCDS

31) What is the purpose of voyage planning?
1. To satisfy STCW regulations
3. To meet company regulations
4. To satisfy IMO regulations

32) How many stages are there in the planning of a safe voyage?

33) A typical ECDIS “base display” shows the following information?
1. Coastline, seamarks and traffic separation schemes
2. Coastline, danger areas and soundings

4. Information according to operators choice

34) What is the main purpose of the zoom function?
1. To select an area of special interest
2. To deselect an area of no interest
3. Toreselect a previous area of special interest

35) What is the main purpose of the pan function?
1. Deselect an area of no interest

3. Change chart scale
4. Reduce displayed information
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36) The ECDIS system can operate in how many modes?

2. Three
3. Four
4. Five

37) What is the definition of a waypoint?
1. A way-point is a position on a leg
2. A way-point is the starting point of a voyage

4. A way-point is the destination of a route

38) What is the definition of a leg?

2. Aline connecting the start and end position of a route
3. Alinein the direction of the next way-point
4. Aline in the direction of the previous way-point

39) How can the ships course change be described in detail?
1. By specifying ships present and future course
2. By specifying ships present and future heading

4. The ships course change can not be described in detail

40) What is the purpose of the “off track” limit?
1. Give warning about possible danger

3. Give warning about possible grounding
4. Display warning limits on ECDIS

41) When the route planning process is completed, what should then be done?
1. Store the route in a safe way
2. Make a safety copy of the route data
3. Checking basic route data

42) If own ships position is erroneous on an ECDIS system, what is the result?
1. All other positions on the chart are erroneous
2. The distances to other positions on the chart is faulty
3. The direction to other positions in the chart is faulty
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43) What is the most important thing to know about computerised systems?
1. Their functions
2. Their features
3. Their technical capacity

44) Does STCW specify special training in use of ECDIS?

2. Yes
3. Only for ships over 10 000 DWT
4. Only for ships carrying dangerous cargo

45) When own ships position input to ECDIS is wrong, what is the result?
1. Nothing
2. ECDIS will give warning
3. ECDIS will automatically be switched off

46) What is the effect of sailing in “Course mode”?
1. Ships course will automatically be corrected for off-set

3. Ships course will be great circle
4. Ships course will be rhumb line

47) Before using a pre-programmed ECDIS route, what should you do?

2. Check own ships position
3. Check all way points
4. Check log and gyro input

48) What does a navigator who uses an ECDIS require?

2. Good computer knowledge
3. Good system knowledge
4. Nothing special
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CD # 88 Human Relations

CoCTOMT 13 WeCTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

Which are the 4 most commonly occurring types of accidents?

w

Leakage
4. Bad weather damages
Engine breakdown

What kind of information does the Fire Plan contain?
1. The fire alarm signal, general fire instruction and your assignment for fire alarms

3. How to use the fire-fighting appliances and equipment on board
Information on how to handle different types of fires

E

Where can you find information about the various kinds of safety equipment you have onboard?

2. MARPOL

4. General Arrangement Plan

What must you do if you detect a fire?

2

Immediately muster at your fire station
3. Inform the bridge and wait for further information
4. Close all ventilation and then try to put out the fire

What is the first thing you must do if you see a person fall over board?
1. Sound the general alarm
2. Inform the bridge
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What is OPA an abbreviation for?
1. Oil Prevention Association

3. Oil Producing Agency
4. Oil Producers Agreement

What is the connection between the quantity of oil transported at sea and the amount of oil spilled
the last years?
1. The quantity of oil transported has decreased and the amount of oil spilled has increased

3. Both has increased
4. Both has decreased
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8) Which of the 5 annexes includes regulation about garbage handling onboard ships?
1. Annexl|

w N
> >
5 5
5 5
CI¢)
X X
= =

9) What kind of ships are regulated by OPA 90?
1. Oil and chemical tankers
2. Passenger ships, ferries and private vessels over150 tons

10) Which of the following are enclosed spaces?

2. Engineroom
Pump room

7. Forecastle

11) Do you need to measure oxygen levels before entering an enclosed space?

2. No
3. Not if you measure for toxic gases
4. Yes, but not if you ventilate properly first for 24 hours

12) Do you need to report near accidents?
1. No, you only need to report an accident that has actually happened
2. You only need to report those near accidents caused by faulty equipment
3. You only need to report those near accidents that in your opinion could have caused sick leave
for more than one day

5. Many near accidents will lead to more serious accidents. By reporting a near accident you may
be preventing a serious accident from happening.

13) Why is it important that everyone onboard can understand and be understood in English?
1. Cargo documentation and handling instructions are usually in English
2. Local authorities in some ports may require crewmembers to take a test to check their ability to
speak English
3. All navigational, engine room and pumping equipment is labeled in English

14) What should you avoid when receiving work orders?
1. Having other people help you with your work
2. Swearing
3. Wasting time on having procedures explained
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15) Emergency communications should be:

2. Repeated every hour until help has arrived
3. Only used if the “situation” has gotten out of control
4. Only sent by the navigation officer
16) All crew are required to:
1. Be able to communicate with each other in the vessel’s flag state language

3. Know how to operate all radio equipment onboard
4. Know how to operate the PA equipment onboard

17) Are you allowed to use any drugs if you are outside Coastal waters?
1. Yes, if you are off duty and have permission from the Master
2. No, not if you have less than 4 hrs until you go on duty

4. VYes, if you have purchased them in a country where they are legal

18) In addition to a common language, what else is important for good communication in reference to
human relations?
1. The ability to communicate in Morse code

3. Knowledge of symbols used in flag signaling
4. Being able to shout loud enough so that you can be heard in noisy environments
5. In addition to a common language, the use of body language, posture and tone of voice is

important for good communication in reference to human relations.



CD # 89 Medical Care

CocTtouT 13 BOCbMMU [/1aB.
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1)

2)

3)

4)

5)

6)

Which statement is correct?

1. Burns should be treated with care to sterility, but these are seldom infected because the plasma
that drains from them contains anti-bacterial matters.

2. Internal bleedings are difficult to localise, but they are seldom life threatening, because the
hollow cavities in the body are too small to contain a serious bleeding.

4. After sewing, the stitches should be left for at least 14 days to be sure there is a strong healing.

Acute abdominal condition should be treated with:
1. Give fluid by month

3. Give food by mouth

5. Give stronger drugs (Morphine) at once

On what injury/injuries should ointment be used together with gauzed dressings?
1. On wounds only

2. On wounds and burns

3. On strains and burns

What kind of wound is shown on the picture?

N,

1. Lacerations

3. Abrasion
4. Puncture wound

In case of more severe pain, as in burns, fractures, acute abdominal pain etc, it might be necessary
to employ more potent drugs such as morphine.

2. False

What is ICE an abbreviation for?

1. Immobilize — Conscious — Elevation

2. Ice —Compression — Examination

3. Immobilize — Compression — Examination

5. The correct answer is; ICE is an abbreviation for Ice — Compression — Elevation.
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7) Stewards or one of the persons in the galley department should be selected as the nurse onboard.
1. True

8) What is the most important measure taken by nurses to prevent spread of disease between
patients?
1. Mouth mask
2. Use of special clothing
3. Patients in single rooms

9) A person who may have become a carrier of the disease should not be allowed to prepare or handle
food or utensils until cleared for such duty by a doctor.

2. False

10) The patient room temperature should be?
1. 18-21 Degree Celsius

3. 20 Degree Celsius
4. 23 Degree Celsius

11) In acute situations, how often should you monitor the primary parameters and record them?
1. Every 5 minutes

3. Every 30 minutes
4. Every hour

12) What causes myocardial infarction?
1. Spasm (cramp) in the coronary vessels and heart wall.
2. Embolus traveling from the veins in the legs.
3. High glucose level in the blood.

13) What vaccine should not be trusted completely?

2. Tetanus
3. Mumps
4. Yellow fever
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14) A person has the following symptoms: 1. Radiating pain to the neck, left arm and abdomen 2.
Nausea 3. Breathlessness. What does these symptoms indicate?

2. Pulmonary embolus
3. Cetoacidosis
4. Sepsis

15) What is the most common sexually transmitted disease in the western world?

2. Syphilis
3. HIVandAIDS
4. Hepatitis A, Band D

16) Which of the following diseases may be treated with penicillin? Mark the answers you think are

correct.
1. Chlamydia

Hepatitis A

T

IV

3.
4,
5.
6. HepatitisBand C

17) If the throat is covered with a grey layer, that is a sign for:

L. Diphtheria

2. Plague
3. Lepra
4. Typhoid

18) What sort of infection is Malaria?
1. Tropical bacterial infection
2. Tropical viral infection

4. Tropical fungal infection

19) Gingivitis is inflammation of the gums

2. False

20) In temperate climatic condition, how much fluid should you give a person suffering from
dehydration?
1. 1litre

3. 3litre
4. As much as the person wants to drink.
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21) What should you give a person suffering from malnutrition the first two days?
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3. Small amount of normal food
4. As much food as the person wants

22) Which of the following procedures are correct to follow after a death onboard a ship?

2. Do not strip the body for all clothing

23) You should try to delay the birth, if the ship can reach the shore within some hours.
1. True

24) Which of the following statement are correct?

1. Once the widest part of the baby’s head is visible, make sure that the mother carry through a
big push.

3. Pull on the baby’s shoulders.

5. Smack the baby if he/she doesn’t cry.

25) Even a small piece of the afterbirth left inside the mother can be dangerous.

2. False

26) Drag each stage to the correct "Symptoms and signs" description.
1. Mild contractions before the afterbirth is expelled
2. Head emerges and the baby is pushed out rapidly
3. Contractions, with an average interval of 10 - 20 minutes

27) Drag each stage to the correct "What happens" description.
1. "Water" (amniotic fluid) break as the need for protection end FISTAGENM
2. Womb should contract, closing down the area to which the placenta is attached and stopping

the bleeding EISTAGES

3. Vagina stretches to allow the baby to be expelled -

28) What language should the medical record be written in?
1. The language spoken onboard

3. Both English and the language spoken onboard
4. The language required by the Company
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29) The medical record should be available to the patient, on his request.

2. False

30) The weight of the patient is not necessary to inform the doctor about, only the age and sex of the
patient.
1. True

31) When moving and transporting a patient, primary attention should be paid to the basal functions —
ABC. What does ABC stand for?
1. Airway — Bleeding - Consciousness

3. Airway — Bleeding - Circulation
4. Airway — Breathing - Consciousness

32) In patients with suspected fractures, it is essential that you do not stabilise the limb/spine prior to
transportation.

2. False
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CD # 91 Incinerators

CoCTOMT 13 WeCTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPpMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

The Temperature in the combustion chamber can vary between 850 Cand ... C
1. 900

2. 1200
3. 1400
4. 2000

Where is the legal to dispose plastic?
1.

2. Within 3-12 miles ashore

3. Wirhin 12-25 miles ashore

4. OQutside 25 miles ashore

The suction from the flue gas fun creates a ....... pressure un the combustion chamber
1. Atmospheric

2. Negative

3. Positive

Which key should be pressed if you want to see the history alarm log?

1. [INFO]
2. [ACK]
3. [05
4. [PREV]

At which chamber temperature can the sluide door be opened and feeding of garbage can start
1. 200

2. 600

3. {50

4. 1200

When burning sludge, the sludge will be heated up to which temperature?
1. 45

2. 88

3. 145

4. Aslongasitis more than OC it does't matter.

What can you throw overboard within 3 miles of the nearest land & in all inland waters?
1. You can throw floating lining and packing materials overboard.

2. The only thing you can't throw overboard is plastics.

3. You can throw food and glass overboard.
4

The Temperature of the flue gas should not exceed......?
1. 200
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2. B850

3. 650
4. 1200

9) What should the diesel oil pressure be at the diesel oil burner?
1. 0.4 bar
2. 1bar
3. 16 bar
4.

60 bar

10) The Maximum suction height from the tank to the D.O. Burnet is.....?
1. 55
2. 6.5m
3. 9m
4. 12m



CD # 109 AIS - Automatic Identification System
COCTOUT M3 WecTU rnas.
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1)

2)

3)

4)

5)

6)

7)

What kind of system is AIS?
2. Radar system

3. ECDIS system

4. Navigation system

Seen from an operational point of view, how will you describe the AIS?
1. AISis a semi automatic system
2. AlSisa manual system

4, AlSis both manual and automatic

Can AIS with MKD operate as a standalone system?
1. No

3. Only in ship to ship mode

4. Only in ship to shore mode

In case of AIS overload, what can you expect?
1. AIS will shut down
2. AIS will “freeze”

4. Close targets drop

How much can the AIS broadcast mode be overloaded without any significant operational effect?

1. 50-100 %
2. 200-300 %

4. No overload is accepted

The dynamic information update rate depends on?
1. ships size

2. type of ship

3. type of cargo

How often is the static information updated?
1. every 12 second
2. every 3 minutes

4. manual update when necessary.
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8) The AlIS transponder is designed to transmit information?

2. Semi automatically
3. Manually
4. AlSis not transmitting at all

9) When should the AIS transponder normally be activated?
1. When the OOW think it is necessary
2. In coastal waters
3. In open waters

10) The AIS transmitted information is divided into three main groups, which?
1. Ship data, Speed Data and Course data
3. Dynamic data, Destination data and Cargo data
4. Position data, Identity data and Dynamic data

11) How is the voyage related information updated?
1. Automatically
2. Semi automatically

4. No update is necessary

12) How is the AlS technical status checked?

2. Manually
3. No check is necessary
4. During annual service

13) The lost target symbol is shown where?
1. At the bottom of the screen
3. At the top of the screen
4. In operator defined position

14) What is the IMO minimum display requirement for AIS?
1. AIS information on Radar
2. AlSinformation on ARPA
3. AlSinformation on ECDIS
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15) When using AlS the OOW should be aware of?
1. AIlS information is always correct

3. AlSinformation is automatically switched off if not correct
4. AlS information need to be corrected before use

16) What is the accuracy of the AIS information?
1. The accuracy is good
2. The accuracy is not so good
3. The accuracy can be compared with the accuracy of radar

17) What happens when an AlS sensor fails?
1. Nothing

3. AlISis automatically switched off
4. The AIS calculate the missing data

18) What is important to remember when using AlS for collision avoidance?

2. AlISis more accurate than ARPA
3. AlSisnot as accurate as ARPA
4. AlSis not allowed to be used for collision avoidance

19) When is static information entered into the AIS?
1. After the voyage is completed

3. Atsea
4. At the AlS factory

20) What are the criteria for a dangerous target in AIS?
1. A target carrying dangerous cargo

3. A target bigger than own ship
4. A target faster than own ship

21) What is the required minimum ship reporting capacity for AlS according to IMO performance
standards?
1. 1000
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22) What can happen in case of AlS overload?
1. The system will shut down
2. The system will freeze
3. The system will give an alarm

23) Which of the following is defined as static information?
1. Navigational status
2. Safety related messages

4. Route plan

24) The selected target symbol represents?

2. An automatically selected target
3. A semi automatically selected target
4. A targetlost by the AIS

25) Which of the following is defined as dynamic information?

2. Ship's call sign and name
3. Ship's destination and ETA
4. Ship's route plan
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CD # 115 Security Awareness
COCTOUT M3 WecTU rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro Noka OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogum K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

Which of these conventions is The International Ship and Port Facility Security (ISPS) Code a part of?

2. MARPOL
3. The Anti Terrorist International Agreement
4. STCW-95

Who is responsible for issuing an ISPS certificate?
1. The Port State

3. US Coast Guard
4. The insurance company

Which Security Levels requires the highest security alert
1. Security Level 1
2. Security Level 2

What is a Continuous Synopsis Record ?
1. A planincluding all security measures onboard

3. Arecord of all security incidents

4. A plan for continuous maintenance of security equipment

Which of the following areas may be possible restricted areas? (Review all answers)

2. The Mess room

Check the items that can be a possible threat

What is a Declaration of Security?

2. A checklist jointly completed by the Ship Security Officer and the U.S. Coast Guard
3. A document between the port and the cargo owner stating security

4. A document stating the ship’s security level
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8) Who is responsible for the regular security inspections of the ship?
1. The Company Security Officer
2. The Classification Society.
3. The Port Facility Security Officer

9) Who is responsible for the development of the Ship Security Plan?

2. The Classification Society.
3. The Port Facility Security Officer
4. The Ship Security Officer

10) Which two persons check the Declaration of Security?
1. The Company Security Officer
2. The local Coast Guard Officer

11) Which of following are security duties? (Review all answers)

3. Monitoring discharge of cargo

12) During a bomb search, which of the following is an important principle to follow?
1. Try to reach behind bulkheads to find a bomb
2. Know exactly what a bomb looks like

4. Throw any suspicious items overboard

13) From the list below, which is among the recommended actions for a vessel to take, on entering an
area known for pirate activity?

2. To turn off all lights
3. To confine all ship’s personnel to one room onboard
4. To transit at night time only

14) When is a visitor onboard required to present an ID?
1. Only on SECURITY Level 3
2. On SECURITY Level 2 & 3

4. Never



15) What percentage of the baggage is required to be checked at Security Level 1?
1. 25-50% of the baggage is required to be checked at Security Level 1.

3. 100% of the baggage is required to be checked at Security Level 1.
4. 5-15% of the baggage is required to be checked at Security Level 1.

16) What percentage of the ship’s stores are required to be inspected at Security Level 3?
1. 25-50% of the ship’s stores are required to be inspected at Security Level 3.
2. 5-20% of the ship’s stores are required to be inspected at Security Level 3.

4. 50-80% of the ship’s stores are required to be inspected at Security Level 3.
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CD # 121 Ship Security Officer Training System
CocTtouT 13 ABEHAALATU rNas.

1-11 rnaBbl - OTKpbIBaEM Kaxkayto, Haxknmaem NEXT (cTpenka Bnpago), A0 TOro Nnoka oHa He NPonaaerT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cneaywoulen rnase.

12 rnaBa — tect. OTBETHI Ha BCE BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAPMAHTOB OTBETOB.

89



1)

2)

3)

4)

5)

6)

7)

8)

9)

A Ship Security Assessment is integral to the creation of your ship’s security plan.

1. [FGe.

2. False.

Who is responsible for ensuring your ship completes a security assessment?
1. Ship Security Officer.

3. Flag State Administration.
4. Recognized Security Organization.

Which of these tasks is performed as part of the SSA?

1. Assign security duties to ship personnel.

2. Implement measures to address weaknesses in ship security.
3. Train shipboard personnel in their security duties.

The first step in completing an SSA is to:

2. Identify the key shipboard operations, systems, areas and personnel that are critical to protect.
3. List the existing security measures.
4. Develop an onboard security survey checklist.

Brainstorming potential motives for security incidents against your ship helps you to create possible
threat scenarios.

1. True.

2. False.

What is the purpose of the Ship Security Plan?
1. Outline specific measures for your ship to move from security level 1 to 2 and from 2 to 3.
2. Outline the organizational structure for the ship.

4. Detail the duties of shipboard personnel assigned security responsibilities.

Ship Security Plans all look the same.
1. True.

2. False.

Who is responsible for ensuring that your ship’s security plan meets the requirements of the ISPS
Code?

1. Flag State Administration.

2. Ship Security Officer.

3. Recognized Security Organization.

One of the categories of information that must be included in your SSP is:
2. Ship security survey.

3. Threat scenarios.
4. Weaknesses in security measures.

10) Your ship security plan must include procedures for responding to security threats, auditing security

activities and interfacing with the port facility.

2. False.
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11) Records relating to breaches of security and changes in security level must be secured against
unauthorized access and available for review by contracting governments.

2. False.

12) Your ship is berthed at a port that is frequently used for drug smuggling. Which of these measures is
it appropriate to implement?
1. Check the identity of everyone boarding the ship.
2. Secure unattended spaces that visitors have access to.

4. Suspend cargo-handling operations.

13) The Declaration of Security:
1. Details a ship’s security measures.

3. Identifies the security responsibilities of shipboard personnel.
4. States the reporting procedures to government contact points.

14) In which of these circumstances can your ship request a DoS?
1. Your ship is operating at a lower security level than the ship or port itis interfacing with.
2. There is a heightened security risk for your ship and a port facility.

4. Your ship has added a new port to its list of ports of call.

15) Who is responsible for completing the DoS on behalf of the ship?
1. Company Security Officer .
2. Chief Officer.
3. Chief Engineer.

16) The DoS addresses the responsibility for the security of the water around the ship and the
verification of increased threat levels.

2. False.

17) Eavesdropping and phone taps are examples of which threat to information security?
1. Sabotage.

3. Terrorism.
4, Subversion.

18) Which of these types of information is considered sensitive?
1. Ship schematics and HR policies.
2. Way points and training records.
3. Planned maintenance schedule and emergency response procedures.

19) Information about your ship’s security arrangements and procedures is stored electronically. Which
of these measures will help safeguard it from potential threats?

2. Protective markings.
3. Encoded email messages.
4. Work history verification.
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20) A contractor is hired to install new navigation equipment onboard your ship while it’s berthed. For a
period of time he’s left unsupervised and photographs schematics of the ship that he finds rolled up
and stored in the corner of a nearby office. Later, from home, he hacks into the network and prints
off information about the ship’s security procedures. Which of these information security measures
would have prevented his unauthorized access?

1. Protective markings, reference checks, and passwords.
2. Firewall, protective markings, vetting and a secure network.

4. Secure area, passwords, a firewall and protective markings.

21) The purpose of profiling is to:
1. Make judgements about people based on their appearance.

3. Categorize people based on their nationality and ethnicity.
4. Identify different personality types.

22) Which type of profiling is used to obtain information about rival companies and their employees?
1. Criminal.
2. Commercial.

4. General.

23) Which statement about the use of profiling onboard a ship is true?
1. Only visitors can be profiled.
2. Detection equipment can be used in place of profiling.
3. Profilers need at least half an hour to gather the information they need.

24) What are the three tasks of a profiler?
1. Check documentation, conduct physical searches, ask questions.

3. Conduct physical searches, observe body language and behaviour, act intimidating.
4. Check documentation, conduct physical searches, act intimidating.

25) Which of these statements about profiling is correct?

2. Use only open-ended questions.
3. Check the ID of all visitors and some crew prior to boarding.
4. Pay less attention to body language and behaviour and more attention to answers to questions.

26) During a profiling interview, the service man you are questioning starts to act suspiciously. He is:
1. Friendly and cooperative.
2. Professional, courteous and forthcoming.
3. Talkative and good-humored.

27) Part way through a profiling interview with a supplier, the package the individual is carrying arouses
your suspicion. What do you do?
1. Confront the individual and demand that he open the package.
2. Call for help on the radio.

4. Take the package and open it.
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28) Whatis an IED?
1. Atype of gun.

3. An explosive.
4. Anincendiary device.

29) Which statement about IED’s is true?

2. Al IED’s look alike.
3. |ED’s are difficult to manufacture.
4. |ED’s don’t cause serious damage.

30) The best way to identify an IED is to:
1. Measure the size of the object.
2. Shake the object.
3. Weight the object.

31) Which of these are indications that a parcel is suspicious?
1. The parcel smells like chocolate.

3. The parcel came from Joe in the safety department and arrived quicker than expected.

4. The parcel is wrapped in clean, brown paper and is addressed to a crewmember from his wife.

32) What measures should be taken when handling mail?
1. Wear rubber gloves and protective clothing when opening suspicious looking mail.

3. Open any mail that looks suspicious.
4. Tear open letters with your hands.

33) Which of these weapons are widely available and commonly used by criminals and terrorists to
further their aims?

2. Incendiary device.
3. Liquid explosive.
4. Vehicle borne device.

34) Which type of equipment can be used to detect explosives?
1. CCTv.
2. Water cannon.

4. Metal detector.
35) This device can detect a package of drugs inside a large delivery of ship’s stores. What is it?
2. Vapour detector.

3. Security container.
4. Access control system.
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36) You can reduce the need for security guards in certain areas by installing:
1. Vapour detectors.
2. Metal detectors.
3. Water cannons.

37) The best way to ensure you get the equipment you need is to:
1. Buy the most expensive equipment on the market.

3. Buy what everyone else is buying.
4. Buy the newest models.

38) Searches are often triggered by:

2. Lost baggage.
3. The receipt of a shipment of damaged stores.
4. News stories of stowaways.

39) For a search to be effective it must be:
1. Organized haphazardly.
2. Conducted by personnel with limited knowledge of the ship’s layout.

4. Inclusive of all personnel.

40) Which information should be included in your search plan?
1. Areas to be searched.
2. Personnel to be involved in the search.
3. Known hiding spots to be searched.

41) The person who takes a bomb threat call has an opportunity to extract information about the bomb
from the caller.

2. False.

42) What type of bomb search should you conduct to avoid panic when the credibility of the threat is in
doubt and you don’t want to disrupt ship business?
1. External search team.

3. Crew search.
4. Known hiding spot search.

43) Which of these procedures should crew follow when conducting a search?

2. Search the perimeter of the space up to a height of 5 feet.
3. Waitin the area they’ve finished searching until they’re contacted for a status update.
4. Conduct random or spot checks of logical threat areas.
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44) Which of these actions should crew take if a suspicious object that may be a bomb is located during
a search?
1. Throw the object overboard.
2. Cover the suspicious object with a box or blanket.

4. Place the object in a desk drawer or file cabinet.

45) The most effective way to combat the threat of drug smuggling is to:
1. Organize crew into pairs and conduct weekly searches of the ship.

3. Perform routine, but irregular searches using teams of two or more personnel from the same
department.

4. Perform spontaneous targeted searches using teams of two or more personnel from the same
department.

46) The best way to prevent stowaways from boarding your ship is to:
1. Conduct routine, but irregular searches of the ship.
2. Conduct a Nominated Officers search.
3. Search the ship when you arrive at port and again just after leaving.

47) The International Maritime Bureau Piracy Reporting Centre attributes the increased numbers of
hijackings to:

2. Higher crime rates around the world.
3. More crew involvement.
4. Easy access to military weapons.

48) Which of these precautionary measures can reduce the threat of piracy, if implemented?
1. Stay at least 15nm away from the shore.

w

Plan to arrive at port at night.
4. Turn off all of the ship’s lights at night.

49) Which of these actions should you take if your ship is successfully boarded by armed pirates?
1. Fight back.
2. Scream in fear and refuse to cooperate.
3. Keep quiet and ignore any questions you’re asked.

50) Which of this information must be included in a piracy attack alert?
1. The number of pirates/highjackers.
2. The type of weapons being carried by the pirates/highjackers.

4. The number of crew onboard.

51) Assign men to search men and women to search women unless a device such as a metal detector is
used.

N

False.

52) Only search vehicle compartments where you suspect objects may be hidden.
1. True.
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53) Which of these statements about drug smuggling is true?
1. Drugs are difficult to conceal onboard a ship.

2. Drug smuggling is only a problem in certain ports, so only ships sailing in those ports need to
implement preventative measures.
3. The preventative measures you incorporate into your ship’s security plan should be exhaustive,

regardless of the level of threat identified by your ship’s security assessment.

54) What do crew, visitors and contractors all have in common?
1. They’re all employees of the ship.
2. They're all onboard the ship for the duration of its voyage.

4. They're all trained in ship emergency procedures.

55) Which of these statements about drug smugglers modes of operating is true?
1. Individual entrepreneurs usually smuggle large quantities of drugs.

3. Drugs hidden by individual entrepreneurs are usually difficult to detect.
4. An organized conspiracy usually smuggles a small amount of drugs.

56) Which of these are indicators that an individual may be a drug smuggler?
1. The individual spends his or her free time hanging out with others.

3. Theindividual makes small local purchases.
4. The individual is disinterested in the ship’s cargo.

57) Which of these measures would you implement to prevent drugs from being smuggled onboard
your ship while it’s berthed?

2. Check a portion of the bags and packages brought onboard.
3. Search some of the packages, spares and stores received.
4. Eliminate fore and aft deck watch at night.

58) If drugs or suspected drugs are found onboard your ship, follow the five C’s. Confirm, Clear, Cordon,

Control and:
1. Change
2. Chuck

59) When handling drugs:

2. Briefly inhale powders, fumes or vapours to verify the substance is a drug.

3. Shut off the ventilation in the room where the drugs are being stored to ensure any vapours or
fumes do not spread to other parts of the ship.

4. Test out the potency of the drug.

60) If drugs are discovered onboard your ship:
1. Notify the authorities after you arrive at the next port of call.
2. Write a report a few days after the event and describe everything that occurred.
3. Disembark crew and passengers as quickly as possible at the next port of call so the authorities
can conduct their investigation.
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61) Successful training programs build on learners past experience, are delivered with enthusiasm,
present relevant information in a logical sequence and invite participation through varied activities.

2. False.

62) The process of learning involves doing, reflecting, linking and:
2. Contemplating.
3. Acting.

4. Explaining.

63) How many different learning styles are there?

1. 1.
2. 2
3. 3.

64) This is an example of a good learning objective: Given a mock-up of an explosive device, identify the
components of the device with 100% accuracy.

2. False.
65) All training programs have a beginning, a middle and an end.
2. False.

66) The middle portion of a training program takes the most time to plan. Which of these items will
assist you in planning and delivering this portion of the program?
1. An equipment list.
2. A description of the content to be covered.
4. A list of the page references to regulations and other documents that will be referred to in the
program.

67) Using x-ray equipment, perform a baggage search to locate a small hunting knife. Which
instructional technique is appropriate for this objective?
1. Brainstorming.
2. Presentation.
3. Questioning.

68) You’ve just completed a training drill. Which of these guidelines should you follow when giving
feedback?
1. Listen to your hunches and give appropriate feedback.

3. Take a one-hour break for lunch and give feedback after you resume.
4. Give lots of information and examples.
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CD # 122 1S0 14001 Environmental Management

CocTouT 13 NATU rnas.

1-4 rnaBbl - OTKPbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro Noka OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnepyroLLen rnase.

5 rnaBa — Tect. OTBETHI Ha BCe BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

What is ISO 140017

2. IMO regulations dealing with pollution from ships.

3. Standard with guidelines for vessels and ship managing companies pertaining to safety and
protection of the environment.

4. International Ship Operator’s list of approved garbage reception facilities in seaports.

The strategy for pollution prevention and protection of the environment has changed over the
years.

2. Dealing with the pollution problems locally in each country.
3. Leaving it to the industry (including shipping) to implement standards for pollution control and
environmental protection.

Which environment is ISO 14001 about?
1. Working conditions and the environment onboard vessels.
2. Pollution of the oceans from ships.

Implementation and maintaining ISO 14001 — Environmental management —in a company should
involve all employees.

2. No

ISO 14001 are a set of rules and regulations that all ship managing companies must comply with.
1. Yes

A company having ISO 14001 certificate must have a documented environmental policy.

N

No

ISO 14001 requires the top management of the company to commit themselves to prevent
pollution, continuous improvement, comply with rules and regulations and

2. appoint an “ISO 14001” officer.
3. annually present a written review to the board.
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8) Also for ISO 14001 — environmental management — we have an important improvement process
where we can use the phrase : “Plan what you do”, _, “Record it”
2. “Give precise working orders”
3. “Ensure safety”

9) To ensure continuous improvement of our environmental management system we use a PICC circle
where the three first key words are: PLAN — IMPLEMENT — CHECK. What is the fourth key word?

2. CONTINUE
3. CALIBRATE
4. CALCULATE

10) In ISO 14001 the definition of “Environment” is : “Surroundings in which

2. avessel
3. ashipping company

operates”

11) An important part of ISO 14001 is “environmental aspect”. The definition is “Element of an
organization’s activities, products or services thatcan _____ the environment
1. pollute

3. harm

12) Animportant part of 1SO 14001 is “Environmental impact” The definitionis “Any _ _ __ _ ___ __
the environment, whether adverse or beneficial, wholly or partially resulting from an organization’s
activities, products or service.

1. pollution of
2. damage to

13) Why are we so concerned about ballast water in connection with ISO 14001 — environmental
management?
1. It affects the stability of the vessel.
2. Use of chemicals in the ballast water can damage the paint and steelworks of the tanks.

14) Why are we so concerned about the escape of and use of Freon in connection with ISO 14001 —
environmental management?
1. Itisa harmful substance and might cause skin injuries to people.

3. ltis a very expensive commodity.
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15) Where can we dispose of plastic?

2. At ashore facility and at sea in accordance with MARPOL regulations.
3. At ashore facility and at sea only outside restricted areas.

16) Is it required that every vessel shall have a vessel specific “garbage management plan”?
1. No, only for vessels trading on USA.

3. No, only for vessels not having incinerator.
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CD # 123 Risk Assessment and Management
COCTOUT U3 Cemu rnas.

1-6 rnaBbl - OTKPbIBAaeM KaxKayto, Haxknumaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

7 rnaBa — Tect. OTBETHI Ha BCe BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

9)

How many percent of all accidents can be related to human error?
1.

2. 90%
3. 70%
4. 50%

Check the boxes on the factors that can be categorized as human errors

Faulty equipment

Weather conditions

i -

PNV AW

What is the first step in a risk assessment?
1. Likelihood estimation

2. Risk identification

3. Consequence estimation

4. Risk evaluation

Risk estimation is?

1. Calculating how many times an accident has occurred
2. A system to see the consequences

3.

4. Identifying accidents

What is a definition of “ likelihood”?

1. How often a ris can lead to an accident
2. How often an accident can lead to a risk
3. How much | like a risk

4. How often | will do a specific work

What is a definition of “consequence”?
1. How many times an accident occur
2. How likely the consequences are
3.

4. The reduction of likelihood

What do you do with a “Risk Profile Matrix”?
1. Reduce the risks of an accident

2. Reduce the consequences of an accident
3. Check how many times you can do a dangerous job without accidents

4. Check if a risk is acceptable

If a risk is not acceptable you can

1. Continue with your work but be very careful
2. Reduce the likelihood and/or consequence
3. Get more people to help with the job

4. Leave the job to someone else

Check which of the following actions that can be used to reduce the risk in a job



2. Let someone else do the job

10) What should you do before performing any job onboard?
1. Ask your superior
2.

3. You do not have to follow procedures if you have done a thorough risk analysis Check how many
persons you can get to help you
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CD # 125 Hot Work

Coctout 13 AEBATU TNas..

1-8 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

9 rnaBa — Tect. OTBETHI Ha BCe BOMPOChbI _ Ha ogunH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

Which of the following is most likely to lead to a fire or explosion?

2. Performing hot work repairs on an open deck during a ballast passage.
3. Welding in a double bottom tank in a dry dock.
4. Welding at night in the ship yard.

What approach does the ISM Code take towards safety?

2. It requires extensive checklists to be completed at every stage.
3. It contains highly detailed procedures, covering all aspects of shipboard operation.
4. It seeks to identify persons responsible in the event of an incident.

Before any hot work task can take place, what is required?

2. Only an order from the Master or Chief Engineer.
3. The completion of the record in the “Hot Work file”, so that the vessel will pass its audits.
4. A quick check of the intended hot work site to make sure everything seems safe.

Which of the following is the definition of a “Risk Assessment”?

2. A brief visual check of the work site carried out immediately before the work is started, to
ensure that the area is safe and clean.

3. Aninvestigation into the circumstances which have led to an incident, such as an explosion that
occurred during a welding repair.

4. The full and detailed briefing of all team members involved in a work task, to ensure that

everyone is aware of their roles and responsibilities.

A broken hand rail at the bottom of a ladder in a cargo tank is to be cropped and a replacement
length welded in place. Which of the following “permits to work” will be required before this job can
be started? (Select all applicable answers)

3. A “Permit to Work Aloft”.
4. A permit to “Work over the Side”.
5. No permit will be required.
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6) A retaining bracket is to be re-welded to the bottom of a bulkhead in a storeroom off the engine
room. Which of the following areas will need to be checked for the presence of combustible
materials before any hot work is commenced? (Select all applicable answers)

5.
6.

The complete machinery space.
The Engine Control Room.

7) What is the definition of “cold work”?

ok wn

Work that creates a cold spark.

Work that will still create a spark in temperatures of less than 15.6°C.
Work that creates a spark in water.

Work which creates a source of ignition.

An atmosphere in which no flammable vapours are present.

8) When is a tank, compartment or container considered to be gas free?

N

w ) \

E

When sufficient fresh air has been introduced into it to raise the level of oxygen present to that
necessary to sustain human life, that is above 17.9%.

When sufficient inert gas has been introduced into it to prohibit the possibility of combustion in
the presence of a source of ignition.

When a Senior Officer declares it to be fit for entry.

9) Which of the following is the ISGOTT definition of a “Responsible Officer” (or “Responsible Person”)?

N

P w

A person appointed by a terminal and empowered to take all decisions relating to a vessel
alongside, having the necessary knowledge and experience for that purpose.

A seafarer with a Certificate of Competency.

An Officer who has been trained how to complete standard reporting forms.

10) Which of the following is considered as the best location on board for hot work?

Noupkown

A dedicated area, such as behind the accommodation block.

At the actual location of the required repair.

Inside a gas free compartment.

Anywhere within the machinery space.

Anywhere behind the tank deck area.

There is no area on a tanker which is better than any other for hot work; it is equally dangerous
all over the ship.
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11) Which of the following regulates hot work outside the designated space?
2. The SMS through the company Risk Analysis Programme.
3. Instructions in the Chief Engineer’s Standing Orders.
4. Hot work outside the designated space is not regulated.

12) The ship is alongside, but is not working cargo. The vessel’s SMS allows welding in the engine room
workshop without a permit, considering it a designated hot work space. The terminal regulations do
not permit hot work alongside. The Chief Engineer wants to repair a small crack on a section of
pipeline that has been disconnected and taken down below. Can the crack be welded? (Select the
most correct answer)

2. Yes (even though terminal regulations prohibit it, the SMS takes precedence on board).
3. Yes, but the terminal must be informed.
4. Strictly speaking no, but it might be possible during the night.

13) A hot work modification is to be carried out in the middle of the after transverse bulkhead of an
engine room spare gear store. Which of the following could be at risk of damage directly on the
other side of the bulkhead in the fitter's workshop? (Select all applicable answers)

4. Electrical cables on the opposite transverse bulkhead of the fitter’s workshop.
5. The electric light fittings on the deck head in the fitter’s workshop.
6. Spare small bore air and hydraulic hoses hanging in racks on the adjacent longitudinal bulkhead

in the fitter’s workshop.

14) What is the maximum concentration of hydrocarbon gas permitted in the atmosphere in a space
(not a designated space) before hot work can take place?

Less than 3% LFL.
Less than 1% UFL.
Less than 2% Oxygen content.
Less than 8% Oxygen content.

uhwn

15) A section of pipe has been disconnected and taken aft to a dedicated gas safe area on the poop deck
behind the accommodation block. Is it necessary to perform a Risk Assessment?

2. No.
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16) Fire safety precautions that may be taken in preparation for hot work might include which of the
following? (Select all applicable answers)

17) Itis intended to burn some old brackets off a bulkhead in the after end of the machinery space. The
bulkhead to a lubricating oil storage tank is 480 mm away from the closest bracket. Can the repair
take place without further precautionary measures being taken?

2. Yes.

18) For hot work to take place in the machinery space, what is the minimum distance that it can take
place from a bunker tank containing fuel oil?

2. Atleast 600 mm.
3. Atleast 1000 mm.
4. No welding can take place in a machinery space where any of the fuel storage tanks has not

been cleaned to hot work standard and inspected and tested to that effect.

19) At which of the following times should hot work be prohibited on a tanker? (Select all applicable
answers)

6. At anchor.
7. At alay-by berth where no cargo operations are to take place.
8. At night.

20) How might the tank lining (coating) on the bottom of a tank be protected from damage due to
falling molten slag? (Select all applicable answers)

3. By inerting the tank.
4. By rinsing the bottom with Odorless Mineral Spirit before commencing hot work.
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21) A hot work repair is to take place on a bracket in a forward fuel tank. The tank has been cleaned and
gas-freed but how should the heating coils in the tank be treated before that hot work begins?

—

2. They should be continuously blown through with fresh air while the hot work repair is taking
place.

3. They should be disconnected and removed from the tank.

4. They should be continuously blown through with inert gas while the hot work repair is taking

place.

22) On this tanker, preparations have been made for a damaged section of heating coil in cargo tank 2
port to be cut away and replaced. The tank has been thoroughly cleaned, gas freed and vented. All
enclosed space entry procedures are in place. The vessel is at sea and all other compartments are

inerted, but still contain residues. What options are there for preparing the adjacent tanks, before
this repair can safely take place? (Select all applicable answers)

4. ltis not necessary to do anything with adjacent spaces.
5. They must be cleaned but it is not necessary to gas free these spaces.

23) On this tanker, preparations have been made for a damaged ladder in cargo tank 4 centre to be cut
away and replaced. The tank has been thoroughly cleaned and gas freed. The vessel is at sea and all
other compartments are inerted. How should the inert gas line to 4 centre be treated, before the
repair can take place?

2. It should be purged with inert gas to not more than 8% by volume of hydrocarbon vapour and
isolated.

3. Itis not necessary to do anything with the inert gas line to 4 port.

4. It must be flushed through and gas freed, with the hydrocarbon vapour content reduced to not

more than 1% LFL and maintained at that level.

24) If hot work is to be undertaken on a bracket under a tanker’s catwalk, at a height of 900mm above
the tank deck, what options are available for preparing cargo tanks within a 30m radius of the hot
work location to the required safety standards? The vessel is at sea. (Select all applicable answers)

4. There is no requirement to prepare such compartments in any way for hot work at this height
above the deck.
5. They should be stripped and inerted to not more than 8% oxygen content by volume.
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25) On this tanker, a hot work repair is to be carried out at a height of 760mm above the tank deck. The
ship is not inerted. Cargo tanks within a specified distance, including those diagonally positioned,
should either have been cleaned and gas freed to hot work standard, or completely filled with
water. What is that specified distance?

2. 100 metres.
3. 25 metres.
4. 50 metres.

26) A what minimum distance is a hot work repair permitted from the bulkhead of a bunker tank,
assuming it has not been cleaned and tested for hot work?

2. 30m.
3. 2m.
4. 30 mm.

27) Wherever possible and for safety, which of the following is the most preferable location for
performing a hot work repair on a cargo line valve?

2. In position.
3. In a gas-free cargo tank.
4. On the poop deck, behind the accommodation, having been disconnected and removed from

the tank deck.

28) How can a welder, working in a confined and restricted area and in close contact with the ship’s
structure, be additionally protected against the risk of electric shock through touching the hull or
frames?

2. By wearing knee length boots.
3. By wearing a cotton boiler suit.
4. By flushing down the area with fresh water before welding commences.

29) In general terms, how should hot work close to bunker tanks be considered?

2. Inthe same way as hot work inside a cargo tank.
3. Inthe same way as hot work on pipelines.
4. In the same way as hot work in a dedicated area.

30) On this tanker, a hot work repair is to take place in cargo tank 2P. Tank 3S is diagonally across the
point at which longitudinal and transverse tank bulkheads of the two tanks meet. Is tank 3S
considered to be adjacent for the purposes of hot work requirements?

2. No.
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31) A hot work repair is required on a pipeline on the deck of a tanker. The first available flange at which
the pipeline can be disconnected and isolated is a long way aft, just in front of the pumproom. What
recommended precaution will you follow while the repair is being carried out?

2. Flushing the pipeline continuously with fresh water.
3. Periodically blowing through the pipeline with inert gas and monitoring for oxygen content of at
least 15%.

32) A level monitor is to be installed in a slop tank on a chemical tanker that is not inerted. Hot work is
required. How should the space be treated before that work starts? (Select all applicable answers)

2. Itis not permitted to perform hot work in a dedicated slop tank, unless the vessel is in dry dock.
3. The tank should be inerted.
4. The tank should be pre-washed to remove the majority of residues.

33) Where portable lights are required to adequately illuminate a hot work site, how should they be
used?

2. They should be held by the assistant at a safe distance from the hot work, with leads kept clear
of the working area.

3. Additional illumination from portable lights is not required; there is enough light from the hot
work activity itself.

4. They should be suspended by natural fibre rope at a minimum distance of 2.5 metres from the

hot work activity.

34) Who is responsible for ensuring that adequate arrangements are provided for contractors or work
gangs, temporarily employed on board, to understand and comply with all relevant safe working
practices?

2. The Superintendent.
3. The Contractor.
4. The Shore supervisor.

35) When a ship is in dry-dock, which of the following primarily governs the management of all safety

matters?

2. The shipboard SMS.

3. The Port Authority Safety Regulations.

4. SOLAS.

5. The national regulations of the country in which the dry-dock is located.
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36) The ship is to carry out some steel replacement in and around the forecastle head, following storm
damage. Shoreside contractors are to be brought on board for the hot work. Why must the Risk
Assessment for the intended work take special account of these contractors?

F

2. Because port regulations require that any Risk Assessment requires contractors to be specifically
noted.

3. Because SOLAS 1974 requires that special provision be made for shoreside contractors working
on board vessels afloat.

4. Because such workers are classified as “high risk” under the port regulations.
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CD # 127 Enclosed Space Entry

Coctout 13 NATHaAUATU rnas.

1-14 rnaBbl - OTKpbIBaeM Kaxkayto, Haxknmaem NEXT (cTpenka BnpaBo), A0 TOro NoKa oHa He NPonaaerT u
He noasuTbcsA PREVIOUS (cTpenka BneBo) u kHonka MENU. Haxkumaem MENU, nepexogum K
cneaywoulen rnase.

15 rnaBa — tect. OTBETHI Ha BCE BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

What is the first step in any potentially hazardous work task on board:

Filling out the permits to work.

Taking equipment required for the job into the space.

A planning meeting to discuss how to carry out the repair.
Reporting.

uhwn

What is the principal hazard associated with entry into an enclosed or confined space?

2. The possible loss of communication with those outside the space.
3. Unsafe access arrangements that could lead to a slip, trip or fall.
4. The Responsible Officer’s signature missing from the entry permit.

Which of the following is an acceptable definition of a dangerous enclosed or confined space”?

2. A space or void enclosed by bulkheads and an overhead which, by its design and limited number
of access points, reduces the hazard exposure of any person entering, or working within that
space.

3. A space with limited access, subject to controlled ventilation, which is well-illuminated, routinely

and regularly entered and for which a permit to work has to be issued according to the Safety
Management System.

Which of the following is the definition of a gas free compartment?

2. Onethatis listed on a permit which confirms that the atmosphere contained therein has
flammability, toxicity and oxygen readings above the corresponding minimum recommended
levels listed in the Safety Management System.

3. Onethatis believed to be in an acceptable condition suitable for an intended task, based on the
visual inspection by a designated responsible person.

4. One which the Chief Officer has verbally confirmed to be safe for entry based on his experience

and knowledge.

Which of the following describes the “Responsible Officer”?

2.

A Junior Officer appointed by the Safety Officer to report all activity related to a specific task
within an enclosed or confined space, having the required understanding and knowledge for
that purpose.

A Superintendent appointed by the company to oversee all safety-related activities on board the
ship, capable of delivering specialised training and empowering him to report information
relating to enclosed or confined space entry to the management office.

A Senior Officer, appointed by the Master, who can further delegate responsibility for enclosed
or confined space entry to a selected Junior Officer or Rating.

w
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6) In relation to entry into an enclosed or confined space, what is “approved equipment”?

2. Filter masks and replacement cartridges issued directly by the Chief Officer.

3. Monitors and gas test equipment that have been examined and tested within the previous three
months.

4. Apparatus that has been supplied by an approved safety company.

7) A forecastle store containing paint and chemicals is normally continuously ventilated but the area
has suffered an electrical failure and the ventilation fan has been stopped overnight. How would you
now consider that storeroom?

2. It should be alright for entry but the door should be left open for a few minutes before anyone
enters.

3. Thereis no problem. It is only a storeroom and has been regularly used up until last night.

4. So long as the electrical fault has been corrected, it will be OK to enter without additional

precautions.

8) You are engaged in cleaning out an oil sludge storage tank that has been previously tested and
approved for unprotected entry and for which a valid enclosed space entry permit exists. While you
are working, you begin to smell cargo vapours. Which of the procedures listed below should be
followed? (Select all applicable answers).

The watchman should be sent to get the Duty Engineer.

All personnel in the space should put on filter masks and continue working.

All personnel inside should exit and take a short break while the vapours are dispersed.
An additional portable ventilation fan should be connected.

6.
7.
8.
9.

9) What is the normal oxygen content in fresh air?

2. 16.7%
3. 17.5%
4. 18.2%
5. 22.6%
6. 23%

116



10) Which of the following are standard procedures to observe prior to entry into a dangerous enclosed
or confined space? (Select all applicable answers)

8. The senior rating enters the space first, to carry out a preliminary visual inspection before any
work starts.
9. All tags are removed, thus indicating that there is no restriction on entry.

11) You are in charge of a team that must enter a dangerous confined space to rescue a man who has
collapsed inside. What is your main priority?

2. To get to the casualty as soon as possible and evacuate him to fresh air, even if it means
entering without full safety equipment.

3. To ensure an assistant records all times and other details for the purposes of completing the
report required under the Safety Management System.

4. To collect and prepare an appropriate range of safety equipment at the entrance to the space,

so that whatever is needed can be passed inside without further delay.

12) In the context of this training module, a “Responsible Officer” is...?

2. .. aperson possessing sufficient theoretical knowledge and practical experience of the hazards
that might be encountered in a planned task, in order to be able to assess their likelihood and
potential impact and to define the precautions that will be necessary.

3. ... alunior Officer who is appointed as a deputy Safety Officer

13) Some cargoes are “carcinogenic”’. What does this mean?

They can induce indigestion and nausea.

They will cause 2nd degree burns.

They may cause permanent blindness.

They will trigger an allergic reaction to inorganic cargo vapours.

vk wn

14) A tank that contained a cargo of vegetable oil has been rough-washed with salt water. It has then
been allowed to lie untouched for two days. Which of the following toxic substances is likely to have
been released into the atmosphere within the tank over this period?

2. Nitrous oxide.
3. Ferrous oxide.
4. Nitrogen dioxide.
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15) If a small crack on a bracket in the middle of a bulkhead between two tanks is to be welded, what
atmosphere tests should be performed prior to commencement of the work? (Select all applicable
answers)

3. The atmosphere in all cargo spaces should be tested for oxygen content.
4. The atmosphere in all empty ballast tanks should be tested for flammability and oxygen content.

16) A crew-member is to be sent into an enclosed space to remove remaining sludge deposits from
between the frames and fumes are known to be present. Which of the following would be
considered a safe procedure for him to follow? (Select all applicable answers)

3. Wearing a filter mask.
4. If a mechanical fan is running, he needs do nothing special — the atmosphere should be safe
enough to breathe naturally.

17) When is an enclosed or confined space considered safe and fit for unprotected entry?

2. When cleaning has finished and the compartment has been rinsed with fresh water.
3. When it smells OK from the deck hatch.
4. When somebody else has already gone inside without a gas mask.

18) In safety terms, why might you suspend cargo operations that involve spaces adjacent to a tank
intended for entry? (Select all applicable answers)

3. Because the charter party contract allows for such interruptions without penalty to the
shipowner.

4. Because safety regulations require all operations personnel to assist in any enclosed space entry
procedure.

19) The term “lock out and tag out” is applied to which of the following:

2. Restrictions on personnel against entering certain compartments and spaces on the vessel
without the appropriate personal security tag.
3. The removal of locking devices and withdrawal of advisory notices from valves and switches that

had earlier been secured against inadvertent use during an enclosed space entry operation.
4. The part of a risk analysis where the Competent Person identifies the valves and switches to be
secured by placing a red tag on them.
20) Drag and drop the measured item onto the appropriate meter.

1. Oxygen analyser -
2. Combustible gas

3. Gas detection tubes with pump - [[facesioftoxicigas
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21) What is the minimum steady reading that must be obtained on an oxygen analyser before
unprotected entry into an enclosed space is permitted? (As per general industry standards)

2. 17.5%
3. 22.5%
4. 25%
5. 16%

22) Can an explosimeter detect the presence of a flammable vapour in a space filled with inert gas?
(Select the most correct answer)
1. Yes.
2. No.

23) Can a combustible gas detector be used to detect a gas other than the standard gas on which itis
calibrated? (Select the most correct answer)
1. Yes.
2. No.

4. Yes, but the operator should be aware that toxic gases with a vapour density of greater than 1.2
may produce erroneous readings.

24) Which of the following is a correct statement?

2. Personal monitors provide a warning against oxygen deficiency and hydrocarbon concentrations
throughout an enclosed or confined space in which the wearer is working.

3. Personal monitors are an acceptable alternative to a remote analyser in determining if an
enclosed or confined space is safe to enter in an unprotected condition.

4. Personal monitors are now replacing remote reading meters as the standard equipment for

determining the oxygen deficiency and hydrocarbon concentration within the atmospheres
contained in enclosed spaces prior to entry.

25) Who is permitted to test the atmosphere in an enclosed or confined space for the purposes of
authorising entry?

2. Anyone who can operate the test equipment and is available at the time entry is required.
3. Only Deck Officers
4. Only the person who will be entering the space first.

26) Cargo tank 3 centre has been cleaned and is scheduled for inspection and mopping. You are the
Responsible Officer. When will you test the atmosphere in the tank? (Select all applicable answers)

3. Once every two to three hours during the validity period of the entry permit.
4. Upon completion of the inspection and as the team exits from the tank.
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27) You are to test the atmosphere in a tank prior to entry. If at all, how will you adjust the ventilation?

2. | will have it running at as close to full pressure as possible throughout testing.

3. | will reduce it to minimum around 30 minutes before testing and only speed it up again once
testing is complete.

4. | will close over all the lids and secure the ventilator or pressure/vacuum valve closed, so as to
create an overpressure within the space.

5. 1 will just test it as | find it, without touching any ventilation that is running.

28) You are to test the atmosphere in a tank prior to entry for cleaning and maintenance purposes.
Where will you take the readings?

2. At the bottom of the space, immediately below the access hatch, because toxic vapours are all
heavier than air and will sink to the bottom and this is the most likely location for registering any
dangerous readings.

3. At the top of the space, immediately inside the access hatch, because toxic vapours are all
lighter than air and will rise to the top and this is the most likely location for registering any
dangerous readings.

29) Whose overall duty is it, to ensure that the plan for entry into an enclosed or confined space is
followed?

2. The Watchman.

3. The 2nd Engineer.

4. The Competent Person

5. The person in charge of the team that will enter the space

30) A small cleaning and repair job is to be done in the after peak tank. The tank is heavily framed, of an
awkward shape, with several distinct sections and built over and around a number of other storage
tanks. Access lids and ventilation pipes are all at the forward end of the tank. You have been
appointed to make the risk assessment and be responsible for the subsequent entry and repair.
How will you ensure the conditions in the area of the repair are fully checked?

2. | would assess and plan as far as possible and then brief those entering the space for the repair
to use their judgement when they get to the after end of the tank.

3. | would enter the tank and take a quick look round to get an overall picture of the general
conditions inside the space and plan the subsequent entry and repair job on that basis.

4. | wouldlook back in the records and find a report from a similar repair in the past. If it was

more-or-less the same situation, | would base my planning on that.

31) You are the Responsible Officer for a maintenance inspection in a ship’s side ballast tank. The after
access manhole has been removed but the compartment is still very dark. How might you safely
improve the situation? (Select all applicable answers)

4. Switch off lighting in other areas.
5. lIssue a flare for the entry team to place and light in the bottom of the space.
6. Tell the team leader to strike a match if he cannot see too well.
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32) You are assigned as the watchman at the entrance to 3 starboard double bottom ballast tank, inside
which the Chief Officer and Cadet are carrying out an inspection. What do you understand you are
permitted to do?

2. | must stay at the entrance until it is time for lunch.

3. 1 was working in the starboard lifeboat before the Chief Officer called me for the watchman’s
duty. If the 3rd Officer tells me to go back to the starboard lifeboat, then | should go, because
that was my original job for the day.

4. Provided | have radio contact with the Cadet inside the tank, itis alright to leave the entrance

and carry on working elsewhere on the deck.

33) You are to be part of a two-man team to enter an enclosed lower deck in the forecastle head. You
are to wear self-contained breathing apparatus and the Responsible officer has decided that a
lifeline is to be used. What must you ensure you can do with that lifeline?

2. |should estimate the distance that the team is to enter the space and ensure that we carry
twice that amount of line in with us, so that if it becomes tangled at the bottom, we can still get
back to the entrance.

3. | should check the label on the lifeline to ensure that the breaking strain is adequate to support
the weight of my colleague, together with the breathing apparatus and other equipment he is
wearing.

4. | should verify that the colour coding on the end of the lifeline conforms to the requirements of

the company Safety Management System, indicating that it is suitable for use in a storeroom
area.

34) You are to enter an enclosed space as part of a small team to undertake some cleaning. How will
you ensure that the operation continues in a safe manner?

2. We must check the Enclosed Space Entry permit to see that the Responsible Officer has
approved the space for a long enough period of time to allow us to complete the cleaning.

3. We should talk to each other the whole time, so that we will always know that everyone is OK.

4. Oneteam member should be assigned to perform watchman duties immediately inside the

space.

35) A crew member doing some cleaning in the bottom a cargo tank reports smelling fumes. What
should now happen? (Select all applicable answers)

5. The crew member should be issued with a filter mask and instructed to continue with the
cleaning.

6. The Responsible Officer should immediately enter the tank to check the situation for himself.
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36) You are the designated watchman at the top of a tank. Three crew members are inside overhauling
a faulty pump. You see one man collapse and hear the other two shouting. What are you going to
do?

2. | willimmediately put a breathing apparatus on and go inside the space and see if | can help the
collapsed man.

3. | will goinside and pull the collapsed man out, because getting him into fresh air quickly could
be critical.

4. | will sound the alarm, then enter the enclosed space and supervise preparations to evacuate
the casualty, because the rescue team will bring the stretcher as soon as they are assembled.

5. 1 will immediately run to the bridge, raise the alarm and then wait there until the Master arrives

to take charge.

37) You are the watchman at the entrance to an enclosed cargo hold. Why must you “tally”, or check
the crew off as they exit the space after finishing their work inside?

2. To record the names for the Chief Officer’s work records and overtime sheets.

3. Because the Chief Officer’s instructions always list that as one of the duties of the watchman.

4. Because the watchman is responsible for all the equipment inside the hold and | need to know
the number of flashlights, personal meters and safety helmets that have been used.

5. Because the watchman is the responsible person for a hold entry and should check his squad are

all present and correct before he dismisses them.

38) You are the Responsible Officer for a cleaning job in a cargo tank. Why must you check around inside
the space once cleaning is completed?

2. Because | have to make sure that all small gear that has been used in the operation is returned
to the locker.
3. Because if anything like that is found during tank or hold inspection, the surveyor might report

it.

39) Place the following steps in the correct sequence, to indicate how a risk assessment is carried out.
Drag and drop the steps onto the numbers:
1

uhwnN e
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40) You are to assist in “securing” a cargo tank after a cleaning squad have been inside. All personnel
and small gear are accounted for and the space is not to be re-entered. Another crew member is
returning the safety and working equipment to storage and the Responsible Officer is taking care of
notifications, documentation and the removal of isolation-tags and notices in the control room.
What should you do at or near the tank itself? (Select all applicable answers)

5. Start pump
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41) If the atmosphere in a compartment is considered to be suspect or unsafe, then it should only be
entered for which of the following purposes? (Select all applicable answers)

4.
5.

For regular cleaning and maintenance under uncontrolled conditions.
If it is the fastest and most convenient way to prepare the space for cargo.

42) You are assisting outside an enclosed space. A maintenance crew are inside and are using air-line
breathing apparatus, supplied from a compressor located on deck close to the manhole cover
access. The compressor has an emergency supply in a cylinder connected via a manifold. The
compressor suddenly stops. You switch over to the emergency supply straight away, but what
should the team inside the space do?

Pwn

They should finish their assigned work as quickly as possible.

Each man inside should take a deep breath, remove his face mask and make his way to the exit.
They should check the local pressure gauge and estimate how much longer they can remain
inside the space.

43) You are the watchman at the entrance hatch to a tank where three men, wearing self-contained
breathing apparatus, are working inside. You hear the low level audible alarm whistle from one of
the sets. What are you going to do?

w N
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Immediately sound the emergency alarm.

Try and establish which set it is that is sounding the alarm, by shouting to, or otherwise
communicating with, those inside.

Take another fully-charged set inside for the user.

Lower a full cylinder into the space for the user and wait to pull the empty one out, so it can be
re-charged

44) What are the employer’s legal obligations in respect of the provision of training on entry into

2.

w

E

dangerous enclosed or confined spaces?

He must provide training, instruction and information on entry into dangerous enclosed and
confined spaces only if a request comes from the Safety Committee of a ship through the
Master.

He must provide general safety manuals, CD’s and videos that could include some basic
guidelines on entry into enclosed spaces.

The Employer is not actually legally required to provide any training at all.

45) Drag and drop the phrases below, re-arranging them to complete safety training bullet points used
in lessons relating to enclosed space entry.

uhwnN e

If in doubt HStaylout]

The greatest risk inside the space

Look after the equipment; you ne\m
Poor planning leads to-

Don’t take short-cuts.
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46) You are the Responsible Officer for a tank entry operation, where the seamen working inside are
being supplied with air from a compressor in the machinery space. Who will you advise of this
arrangement and why?

2. The Officer on Watch on the bridge.
3. The Master.

5. So that the running hours on the compressor can be noted.
6. So that the outlet delivery pressure to deck can be reduced to the combined breathing rate of
the seamen in the tank.

47) Breathing apparatus should be inspected and tested periodically, as per the company maintenance
schedule. When else should it be tested for correct operation?

After leaving port.

2-4 days prior to arrival in port.

When it has been in use in an enclosed or confined space for more than 1 hour.

When it has been in use for any routine or emergency task where it may have been submerged
in water or exposed to water spray.

ukhwn

48) You are the Master of a vessel which normally has a minimum safe complement of four personal
oxygen monitors. Two are to be sent ashore for service in the next port but there is a programme of

ballast tank inspections scheduled in that port. What could you do to ensure that the ship’s

personnel continue to be work under safe conditions? (Select all applicable answers)

3. lunderstand that inspection of the ship is paramount and will issue instructions that the
remaining meters should be continually transferred between tanks to enable at least some
checking of the atmospheres where personnel are working inside the enclosed spaces.

4. | must stop enclosed space entry altogether as two monitors is not legally enough.
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CD # 142 Learning MS Word

CocTouT 13 ABeHaaLaTy r1as.

1-11 rnaBbl - OTKpbIBaEM Kaxkayto, Haxknmaem NEXT (cTpenka Bnpago), 40 TOro Nnoka oHa He NPonaaerT u
He noasuTbcsA PREVIOUS (cTpenka Bneso) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cneaywoulen rnase.

12 rnaBa — tect. OTBETHI Ha BCE BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAPMAHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

File, Edit, View, Insert, Format, Tools, Window, Help are command groups that are displayed on the:
1. Standard Toolbar
2. Formatting Toolbar

4. Drawing Toolbar

There are two ways of exiting MS Word:
1. Clicking the lower ‘X’ icon on the top-right corner of the Window screen

4. Clicking Edit > Go To from the Menu Bar

You can use the Save As command to: (Check all correct options)
1. Change the formatting of the file

3. Change the font style of a document

True or False: To view the hidden commands, you can click the double-headed arrow at the bottom
of the Menu List.

2. False

True or False: To preview a document before printing you can click the magnifying glass, which is the
Preview icon.

2. False

Which command is associated with this icon?

F I Y E— (] x]

JE‘lIe Edit View Insert Format Tocls Table Window Help

ndfasoo- o= g 2
55|

2 | WG gard RSB RSNS

10 =2

J" "|° |ﬁa Fa\-'orites-‘-*-|-§|'3+

1

I’I 4%

IF]

_ Which cormmand is associated with this icon?
1. OpenNew File

2. Prnt file

3. Save file.

4. Print Preview file

PO s T

SeEsd |

[ Page 1 Sec 1 11 jae 1t ln 1 ol 44
1. Open New File.
2. PrintFile.
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7) Which command is associated with this icon?
E — EER

8)

9)

10) Which command is associated with thisicon?

2

G test - Microsoft Word
£dt View Insert Format Iools Table Window Help

ID#E @I |- oo A '_?“m -2

- =+ | 00D @ Q Favortes~ | G- | @

. Which command is associated with this icon?

R 3 R SREa

-

2. Print File.
3. Save File.
4. Print Preview File.

Match the following:

1. OpenNewFils

2 Prntfile

3 Savefile
= 4. Print Preview fil
A -
s a

o

5 £
] EERD) »
[Page 1 Ser 1 g far i | g

1. Reach the start of line JHOME

ukhwn

Match the Keyboard shortcuts with their Functions by dragging and dropping the shortcut

commands on the functions.
1. Ctrl+Vv

2. Ctrl+X
3. Ctrl+z
4, Ctrl+C

Reach the end of the document
Skip and reach certain words
Reach the start of the document
Reach the end of the line[lIENG

il test - Microsoft Word il

| Bie Edt Wiew Insert Format Took Table Window Help

Deds B

0%

-3z

¥

4

J = = ‘ L] . 1o} Q Favarites =

[ o p

~

E_ la. =4

-

]
| ¢

el e

| Page 1 Sec L 11 lat 11"

1. Undo Last Action.

3. Paste Text.
4. Copy Text.

lhz o1
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11) Which command is associated with thisicon?
x|

| Ble Edi Yew Insert Format Tscls Table Widow telp |
DeEs gupdo-c |~ O Y

e O - R

=K > :
[Page 1 Sec 1 1yt facr” lni  Col1 e
1. Undo Last Action.
2. Cut Text.

3. Paste Text.

12) To select a single word in the document:
1. Single click the word.

3. Click in the margin.
4. Right click on the word.

13) To copy the formatting style of a selected line to another text:

2. Use Copy Icon
3. Click Format > Copy
4. Click Edit > Paste Special

14) To format text as shown above, which font effect is used?

l:-_Eltest—Micrusuft Word i ot
| Bl Edit Wiew Insert Format Tools Table Window Help

Ao H|2B<? 90 o -0

N

25t 200 ¢ deg, E = MC2

1. St}ikethrough

3. Superscript
4. Bold
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15) What are the font formatting characteristics like bold, italics, and underline are called?

1. Fonts

3. Font effects
4. Font feature

16) What is the command to choose a Language Dictionary to be used for checking text?
1. Click Tools > Spelling and Grammar.
2. Click Tools > Track Changes.

4. Click Tools > AutoCorrect.

17) What is the feature in Word that recognises and checks spelling, typing errors, and grammar
mistakes called?
1. AutoFormat
2. Autolayout
3. AutoShapes

18) The Find command is located in which menu?
1. File>Find...
2. Insert > Find...

4, Format > Find ...

19) How is an inserted comment in the text document shown?

2. A small red triangle on the word
3. Bold font
4. |Italic font

20) You can use the AutoCorrect feature in a document to correct which type of mistakes?(Check all
correct options)

2. Clear all comments

4. Cancel mathematical functions

21) True or False: You can set the Paper Size by Clicking File > Page Setup to open the dialog box.

2. False
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22) True or False: You can set the number of copies by Clicking File > Print to open the dialog box?

2. False

23) Which command is associated with this icon?
@ Lioix

2. Print Preview.
3. Save.
4. Copy Text.

24) What is the command to set the Margins of a document?
2. File > Properties
3. Edit > Select All
4. Insert > Break

25) What is the default orientation for the printed page?
2. Llandscape
3. The last saved action
4. Vertical

26) What is the correct sequence of commands to add a Page Header or Page Footer?

2. Insert > Cells
3. Insert > Comment
4. View > Page Break Preview

27) What is the correct option to Print a particular page from the active worksheet?

1. Select ‘All’
2. Select ‘Current Page’

4. Select ‘Selection’
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28) What is the correct command to insert a table in a document?

2. Table > Autofit
3. Insert > Table
4. Insert > Index and Tables

29) What is the command to convert an existing text to a table?
2. Select Insert > Picture > AutoShapes.
3. Click Table > Insert > Text.
4. Click View > Toolbars > Tables and Borders.

30) Different styles of format options such as colour and font that can be applied quickly to a Table is

known as:

1. AutoCorrect
2. AutoShapes
3. ClipArt

31) What is the correct command to colour a selected Table row?

1. Table Properties > Row
2. Table Properties > Cell

4. Table Properties > Table > Border and Shading > Border

32) What is the correct command to split selected cell?

1. Table > Table Properties > Cell

3. Table > Merge Cell
4. Table > Split Table
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33) What type of List is shown in the picture?

1.

£
=]
C)

Bulleted

2. Numerical
3. Nested or Outlined

34) What type of List is shown in the picture?

1.

2. Numerical

4. Alphabetical

35) Which is the correct command to create a List as shown in the picture?

11 1. k-]
a) - : s o
MNone i
i1 101
Adicle b Heace 1 Hearling 1 |- Hezdng | O bzading 1
Seclion 101 1 11 Hasding 2 A Heading 2 o1
(&) Heading 1451 Head 1. Hazar 01,1 Headmp 3
Bulleted

Format > Border and Shading

2.
3.
4.

Format > Bulleted & Numbering > Nested or Outlined

Format > Fonts
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CD # 151 HAZMAT - IMDG Code, Advanced

CocTouT 13 ABeHaaLaTyv rNas.

1-10,12 rnaBsbl - OTKpbIBaEeM KaxKayto, Haxkmumaem NEXT (cTpenka BnpaBo), 40 TOro NOKa OHa He
nponageT 1 He nosButbcs PREVIOUS (cTpenka Bneeo) n kHonka MENU. Haxkumaem MENU, nepexoanm
K cnepytolLen rnase.

11 rnaBa — Tect. OTBETHI Ha BCE BOMPOChbI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

Where in the IMDG Code would you find the IMO/ILO/UN ECE guidelines for the packing of Cargo
Transport Units?

Volume 1: Part 4
Volume 1: Part 6
Volume 2, chapter 3.2
Volume 1: Appendix 4

ukhwn

A fibreboard package containing 4 metal cans of Caesium Nitrate, individual weight 1kg each,
transported under the provisions of chapter 3.4 of the Code, will bear which of the following

markings?
1. A
2. B

4. D
5 E

A cargo transport unit contains 50 drums, each with the UN number 2967 displayed on it. Which
number should be displayed in the lower half of the diamond on the placard on the front, rear and
both sides of the unit?

2. 2967
3. 50
4. 3

What medical warnings are found in the Dangerous Goods List for 3-TRIFLUOROMETHYLANILINE?

Corrosive if swallowed.

Causes burns to skin, eyes and mucous membranes.
Poisonous.

High rate of skin decomposition on prolonged contact.

ukhwn

(This question does not include the exception whereby dangerous goods are being stowed “away
from” each other and with the approval of the competent authority) In relation to packing
dangerous goods in a single cargo transport unit, the term “segregated from” means:

2. Not permitted on the same vessel.
3. Must be stowed on deck.
4. Must be separated by at least 3 metres horizontally.
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6) Which of the following types of packaging are covered by the general term “Cargo Transport Unit”?
(Select all applicable answers)

7. Large packagings.
8. Miilitary personnel vehicles.

7) A marking label coloured green will refer to dangerous goods of which class?

Flammable gases.

Flammable solids.

Toxic substances.

Those for accelerated customs processing.

Those with the UN Environmental Committee approval.

ok wn

8) Packages of UN 2861 and UN 1120 are intended for transport by sea. Which of the following
applies?

Must be stowed away from each other.

Must be separated from each other.

Must be separated by a complete compartment or hold from each other.

Must be separated longitudinally by an intervening complete compartment or hold from each
other.

uhwbn

9) When a Cargo Transport Unit is loaded with a mixture of dangerous goods and non-hazardous
materials, how should the dangerous goods consignments be loaded?

2. On the bottom of the unit, to ensure no damage of other cargo occurs in the event of leakage.
3. Away from all doors or openings to prevent falling out when the unit is opened.
4. On top of the non-hazardous material, so as to be readily accessible for priority unloading.

10) Where do you find a list of substances by segregation group and UN number?

Volume 1, chapter 3.1.
Volume 2, Appendix A.

The Supplement, Appendix 1.
Volume 2, Index.

vk wn
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11) According to the IMDG Code, a freight container which is loaded with dangerous goods and which is
intended for transport by sea, must display the placards as described by which of the following
statements?

ok wn

On each side and on the back end of the container.

On each side only.

On the back end only.

On each side, each end and transversely in the middle of the top of the container.

12) Unless otherwise provided in the Code, marking of a package containing dangerous goods of UN
Number 2196 should be:

2.
3.
4.
5.

13) Which of the following are contained in the Supplement to the IMDG Code? (Select all applicable
answers)

4.
5.

TUNGSTEN GASES

TUNGSTEN HEXAFLUORIDE

UN 2196

TUNGSTEN HEXAFLUORIDE CLASS 8

The Dangerous Goods List.
The List of Generic and N.O.S. Proper Shipping Names.

14) “A Shipping Declaration is not required to be provided by the consignor when shipping a package
marked “Dangerous Goods of Class 3— Limited Quantity”. Which of the following is a correct
assessment of this statement?

1. False.
2. True.
3. True only when the total quantity does not exceed 5 litres.
4. True, only when contained in aerosols of not more than 1000 square centimetres, contained
within an inner packaging.
(a)1H2..
15) What material would a drum, the marking on which began with be

constructed from?

uhwnN e

Plastics.

Steel.

Aluminium.

Metal, other than steel or aluminium.
Fibre.
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16) Which of the following is used to denote a Marine Pollutant in the Dangerous Goods List?

o kwnN

MP
P(M)
PP
MarPol
SMP

17) To what source of safety information would you refer in the case of a spillage of a substance
identified with the UN number 12307

uhwbN

EmS schedule F-E.

MFAG Table 16.

Dangerous Goods List, column 16.
IMDG Code, chapter 7.2, table 16.

18) To what source of safety information would you refer in the case of a fire involving a substance
identified with the UN number 22577

uhwbn

EmS schedule S-N.

MFAG Table 17.

Dangerous Goods List, column 12.
IMDG Code, chapter 7.2, table 4.

19) What does the Code say about the transportation of CHLOROPRENE, STABILIZED as a “limited
quantity” under the provisions of chapter 3.4?

n

w

b

The entry in column 7(b) of the Dangerous Goods List is “none” and therefore indicates that
there is no restriction on this substance being transported as a limited quantity shipment.

The entry in column 16 of the Dangerous Goods List indicates that the substance should be
stowed clear of living quarters. A limited quantity can therefore be carried, provided it is stowed
more than 24 metres away from the accommodation.

The entry in column 8 of the Dangerous Goods List refers the user to a Packing Instruction,
which explains how the substance may be transported under “Limited Quantity” requirements.”

20) What special packing provisions would apply to an IBC, of construction code 11A, used for the
transportation of OSMIUM TETROXIDE?

n

P w

Such an IBC shall be sift-proof and water-resistant or shall be fitted with a sift-proof or water-
resistant liner.

Such an IBC shall meet the performance group Il performance level.

IBCs shall not be used for the transportation of this substance.
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21) What provisions apply in respect of dangerous goods in limited quantities that are packed and
distributed in a form for sale through retail agencies for personal or household use? (Select all
applicable answers).

22) How would you expect to find a package that previously contained a consignment of UN Number
2067 marked? It is in an uncleaned condition and there are still heavy residual vapours inside the

package.

2. Empty packages are not required to be marked.
3. EXUN 2067.

4. Empty after AMMONIUM NITRATE.

5. Empty after UN 2067.

23) What are the Proper Shipping Name and UN Number for the substance Bromomethane?

uhwbn

BROMOCHLOROMETHANE UN 1887.

BROMOMETHANE, UN 1062.

BROMODIPHENYLMETHANE, UN 1770

METHYL BROMIDE AND ETHYLENE DIBROMIDE MIXTURE, LIQUID UN 1647

24) Where in the IMDG Code do you find the provisions relating to Temperature Control?

2.
3.
4.
5.

Appendix A of the Supplement.

Column 9 of the Dangerous Goods List.

Column 17 of the Dangerous Goods List.

Section 5.3.2.2 “elevated temperature substances”

25) Drag and drop the substance names to match the correct provisions and descriptions:

=

2.

w

E

o u

Stowage Category A stowage, keep as cool as reasonably practicable. _
Homogeneous mixtures containing not more than 35% by mass and at least 65% of inert
substance are not subject to this Code unless criteria of other classes are met.

Flexible IBCs shall be sift-proof and water-resistant or shall be fitted with a sift-proof and water-

resistant iner. BERESHAMEIORGSITEREE

Marine Pollutant; Packing Group 1; Not permitted for transport under Limited Quantity
provisions;

In contact with acid, evolves silane, a spontaneously flammable gas. _

EmS Fire Schedule E, Spillage Schedule D.
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26) To which explosives compatibility Class are “Articles containing a secondary detonating explosive
substance, without means of initiation, with a propelling charge (other than one containing a
flammable liquid or gel or hypergolic liquids) or without a propelling charge” assigned?

ok wn

O 0O

27) What pressure relief provisions apply to the carriage of TRIETHYLENETETRAMINE in portable tanks?

N

w

E

Such a tank is required to have an approved relief device constructed of materials compatible
with the load.

Such a tank is required to have a relief device comprising a frangible disc preceding a spring-
loaded pressure relief device.

Tanks containing this product are not fitted with a pressure relief device.

28) Where will a dangerous substance, material or article not mentioned specifically by name in the
Dangerous Goods List appear?

2.
3.
4.

In the Glossary of Terms.
In Packing Provision P200.
In the List of Class 9 Substances, Materials and Articles.

29) Which of the following is a description of a gas?

N

w

Matter in its most concentrated form; having a close-packed and regular crystalline structure;
can be melted by heat, but may be of a high level.

A non-crystalline form of matter, falling between the solid and liquid states; of definite mass,
difficult to compress; no permanent shape and the molecules are free to move within the limits
of any container; varying greatly in viscosity, melting point, vapour pressure and surface tension.

30) Which of the following is a correct statement?

N

w

Substances in the surrounding environment can have no dangerous impact on packaged
dangerous goods.

A dangerous reaction between a substance or article and other substances in the surrounding
environment is only possible if those goods are packaged in a container constructed of soft and
non water-resistant material.
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31) Which of the following shall apply to packagings in direct contact with dangerous goods? (Select all
applicable answers)

o kW

They shall be constructed of non-porous material.

They will absorb a rise in surface temperature of not more than 20°C as a result of such contact.
They will not exhibit any visible distortion directly attributable to such contact.

They will be deliver an equivalent standard of protection to a class 2 (sift-proof and water-
resistant) liner.

32) According to the guidelines in the IMDG Code, what temperature should be used when calculating
the maximum volume to be loaded to a tank container be calculated, in order to avoid leakage or
distortion resulting from expansion due to temperature change during transport?

ok wnN

55°C.
60°C.
100°C.
15.6°C.
38°C.

33) Which Packing Group is assigned to substances presenting a low level of danger?

1.
2.

Packing Group I.
Packing Group II.

34) Drag and drop the alpha-numeric codes as found in the Dangerous Goods List onto the applicable
packing Instructions and Special Packing Provisions:

1.

ok wnN

Packing Instructions for packagings other than IBCs and large packagings. I
Packing Instructions for Intermediate Bulk Containers. |

Packing Instructions for large packagings. .

Special Packing Provisions for packagings other than IBCs and large packagings. .
Special Packing Provisions for Intermediate Bulk Containers. I

Special Packing Provisions for large packagings. I

35) Which of these is the UN Packaging Symbol?

09
A

1.

2. B 5. (n)
3. ¢C

4. D C-@
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36) What is salvage packaging?

2. Packaging used only at the direction of a contracted environmental protection response
company.

3. Packaging which has been reconditioned after previous use.

4. Packaging which is manufactured from recycled material.

5. Packaging in which goods recovered from the sea are held, pending investigation by the

appropriate authority.

37) Which of the following are considered a “Cargo Transport Unit” under the IMDG Code? (Select all
applicable answers)

7. Military personnel carrying vehicles.
8. Large plastic barrels of 150 litres or more.

38) Within the IMDG Code, the term “labelling” refers to which of the following?
2. ldentification of the substance contained in a package.

3. lIdentification of the risks and hazards presented by substances contained in cargo transport
units.

39) Within the IMDG Code, the term “marking” refers to which of the following?

2. ldentification of the risks and hazards presented by substances contained in a package.

3. lIdentification of the risks and hazards presented by substances contained in cargo transport
units.

40) A "Consignee” is which of the following?

2. Any person who prepares a shipment for transport.
3. A shipment of dangerous goods.
4. A member of a competent authority charged with the administration of the transportation of

dangerous goods.
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41) Proper Shipping Names and UN Numbers are used for which two primary purposes?

1.

4.

To ensure that the substance, material or article can be readily identified during transport,
especially in the event of an emergency.

To provide the necessary information for the Master to be able to comply with reporting
requirements in the event of a pollution incident.

To complete the additional security documents when entering a port subject to a leve
security alert.

To demonstrate compliance with MARPOL 73/78 when subject of a Port State Inspection.

Iu g

orange”

42) Which of these labels is used to indicate a marine pollutant?

43) Drag and drop the correct class descriptions onto the applicable classes labels:

1.

PNk WN

Flammable Gases.

Non-flammable, non-toxic gases.

Substances which, on contact with water, emit flammable gases.
Infectious Substances.

Corrosive Substances.

Explosives, division 1.5.

Flammable Solids.

Toxic Substances.

-
| Infectith Jtances. |
g

-

r
>I‘IEE§. |
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44) Which of the following details should be included in a manifest of dangerous goods loaded on board
a ship? (Select all applicable answers)

45) Where would you stow a package of dangerous goods, subject to the provisions of Stowage
Category D, on a cargo ship, of length 81 metres overall, carrying 24 passengers?

2. Such stowage is PROHIBITED.
3. Either ON DECK or UNDER DECK.
4. In alocked cargo compartment.

46) When related to the “on deck” stowage of packages, which of the following is a definition of the
stowage term “away from”?

2. Either in a vertical or horizontal separation. If the intervening decks are not resistant to fire and
liquid, then only in a longitudinal separation is acceptable. For “on deck” stowage, this means a
distance of at least 12 metres. This distance also applies to one package stowed “on deck” and
another in an upper compartment.

3. \Vertical separation alone does not meet this requirement. Between a package “under deck” and

one “on deck”, a minimum distance of 24 metres, including a complete compartment, must be
maintained longitudinally. For “on deck” stowage, this segregation means a minimum distance
of at least 24 metres longitudinally.

47) Which of the following is a definition of the control temperature of a dangerous substance as
applicable to the IMDG Code?

2. The lowest temperature at which decomposition may occur for a substance in a packaging as
used in transport.

3. The temperature at which emergency procedures shall be implemented.

4. The temperature at which the goods are discharged.

5. The overall average temperature drawn from daily observations on passage.
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48) The Medical First Aid Guide for Use in Accidents Involving Dangerous Goods provides advice
intended for which of the following?

—

n

w

v e

The comprehensive and total management of chemical poisoning and diagnosis to full recovery,
with assistance from shore as required.

The proper documentation to the flag state authority in the event of a fatality involving
dangerous goods on a vessel.

The limited care of casualties in exposure incidents involving liquid chemicals.

The accurate transfer of information relating to a spilled cargo to the appropriate shoreside
medical and environmental agencies.

49) Drag and drop the appropriate steps to show the three stages in the correct sequence to be used
when applying the MFAG:

1.
2.
3.

Sequence 1
Sequence 2
Sequence 3

50) The classes drawn up by the UN Committee of Experts when writing the IMDG Code were based on
which of the following?

vk wn

o

Alphabetical order.

UN Number.

Laboratory tests of different chemical groups.

The average tonnage of different groups of dangerous substances shipped worldwide in
packaged form.

Pre-existing airline rules.

51) Which of the following symbols would you expect to find on a thermal tank containing liquid of a
high temperature?

L < - K

Pwnmn

B>

OO0 w
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52) Which of these labels would be attached to a package containing explosives?
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CD # 160 52 Fire Fighting (Basic)

CocTouT 13 BOCbMMU [1aB.

1-7 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknumaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcs PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnepyrouLen rnase. B KoHLe KaxkAoM rnasbl eCTb BONPOCHI, Ha HUX Hazo OBA3ATE/IbHO OTBETUTD, He
BaXHO MPaBUIbHO WU HET.

8 rnaBa — Tect. OTBETHI Ha BCe BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJIbKO BapMaHTOB 0TBeTOB. OTBETLI B3ATbl U3 06HOBEHHOM Bepcum TecTa (cd 160), n HECKONBbKO
BOMPOCOB MOKET HEDObITb UM OHU MOTYT BbITb CHOPMYNMPOBaHHbI MHAYe (52). JaHHbIX OTBETOB XBATUT
4yTObbI CAATH TECT MUHUMYM Ha 90%, Yero AOCTaTOYHO AJ1S YCNELIHOTO NPOXOXKAEHUS.
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1)

2)

3)

4)

5)

6)

Where can you find an overview of where the powder extinguishers are located?
1. In SOLAS.
IMO.

2.
3. The fire control and safety plan.
4

The emergency plan.

Do we call it "suffocating the fire" when we remove the oxygen from the fire?

1. ¥&

2. No.

Does there have to be oxygen present to light a flammable gas?
1. No.

2. @

3. Only with special gasses.
4. Only with special fluids.

What fire extinguisher is most suitable for putting out fires in metal?

1. Water.
2. Powder.
3. Co2.

4. Special powder.

Can National Maritime Authorities and Classification Societies require additions to the SOLAS
requirements?

1. No, only National Maritime Authorities.

2. No, only the Classification Society.

3. .

4. No.

Does the Muster list and the Emergency Instructions contain information relevant only to the deck
officers?

1. Yes.

2. No, relevant to all officers.

3. No, all crew members and other personnel onboard.

4. No, only the crew.
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7) In order for there to be a fire, there has to be an unbroken chain reaction between three

components.

One of the components is the combustible material.
What do you think are the two other components that have to be present in order to start a fire?

CcOo2
Halon
Wood

Heat
-

Combustible
material

Heat

In order for there to be a fire, there
has to be an unbroken chain reaction
between three components.

cne of the components is the
combustible material.

Choose the two other components
that have to be present in order to
have a fire.

coz Wood

Halon

I'm done! I

8) For most products the fire will die out when the oxygen content is reduced to?

1.

2.
3.
4

10%.

15%.
21%.

9) How do we normally remove the heat from a class A fire?

1.

2
3.
4

Use of CO2 or foam.
Halon or powder.
Powder or CO2.

10) The temperature at which a product will give sufficient vapour that can be ignited is known as the

Gas.

Flammable.

Vapour.

point of the material.
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11) LEL+UEL

The correct answer is;
| Combustion OM: Optimal mixture
intensity HC gas [ Air
LEL UEL
0 1 4 5 6 7 8 9 10 1
Volume percentage
of gas in air

%

12) Which of these materials has the best heat conduction?
1. Gas.

2. Liquid.
3. Metal
4. Wood.

13) What does heat radiation mean?

1. A process in which the heat is spread from one molecule to another molecule.

2. A process in which warm or heated molecules start moving.
3.
4. A process in which heat waves starts a fire where the waves meet.

14) CO2 is especially suitable for fighting one or more of the fire categories, which category?

1. Class A, Ordinary combustible materials.

1

4. Class D, Metal.

15) Which fire extinguisher's could you use to put out burning oil?

3. Water (applied by jet).
4. Water (applied by spray).

16) A CO2 system extinguishes a fire in a protected space by...

1. Cooling down the fire.

2. Reacting chemically with the fire.
3. Depriving the fire of oxygen.

4. Blow out the flames.
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17) Is this statement true or false?
"Always attempt to extinguish a fire before sounding the alarm".

1. Faleg

2. True

18) A sprinkler system is normally used to protect the ...................
1. Engine room.
2. Accommodation area.
3. Galley ducts.
4. Tanks on a chemical tanker.

19) e is listed as a CFC gas, as of January 1st 1994 .......... system is not installed onboard new
ships.
1. Nitrogen
2. Halon
3. C02
4. Propane

20) Where do you always find operation and maintenance instructions for the extinguishers?
1. On the Muster list and Emergency Instructions.
2. On the label of the extinguisher.
3. Displayed in the cabin.
4. InSTCW.

21) Who is in charge of the operation if there is a fire in accommodation?
1. Master.
2. Chief Engineer.

3. Chief Offcer.

4. Fire Squad 1.

22) Which team/squad has the following duties? Stop requested ventilation, close fire flaps and start
emergency fire pump if ordered.
1. Firesquad 1.
2. Firesquad 3.
3. Bridge team.

4. Technical squad.

23) What kind of work is hot work?
1. Dismantling a pump.

2. Chipping.
3.
4. Cooking.

24) What do you do if you detect a fire?
1. Immediate muster at your fire station.
2.
3. First try to extinguish the fire and then activate the alarm.
4. Report to bridge.

25) What information can you find on the fire control plan?

1. The location of the fie-fghting appliances.

2. How to use the fire-fighting appliances correctly.
3. How to respond in case of fire.
4. Where the Master can be reached in case of emergency.
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26) It is important to get familiarised with the emergency exits on board the vessel, at what time should
this be done?
1. Within a week.
2. Immediately after boarding.
3. Before boarding.
4. When you have some extra time.

27) What type of fire detectors is the first to go of in case of a fire?
1.
2. Flame detector.
3. Heat detector.
4. Gas detector.

28) Emergency compressed air breathing escape sets onboard, shall have a duration of service no less
then:
1. 20 minutes.
2. 15 minutes.
3. 8 minutes.
4. 9 minutes.

29) According to SOLAS the breathing air apparatus that must be onboard shall have sufficient capacity
for how many minutes of operation?
1. 20 minutes
2. 30 minutes.
3. 45 minutes
4. 25 minutes.

30) Ignition, flammable, flash

The temperature at which a product will give sufficient vapour that can
be ignited and will continue to support combustion after the
application of an outside source of ignition is known as the ignition
point of the material.

A hydrocarbon gas mixture and air cannot be ignited and burned unless
its composition lies within a range of gas-in-air concentrations, known
as the "flammable range".

Flash point is the lowest temperature at which a liquid gives off
sufficient gas to form a flammable gas mixture near the surface of the
liquid
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CD # 161(52) Fire Fighting (Advanced)

CocTouT 13 WecTn rnas.

1-5 rnaBbl - OTKpbIBAaeM KaxKayto, Haxknmaem NEXT (cTpenka BnpaBo), 40 TOro NoKa OHa He nponageT u
He noasuTbcs PREVIOUS (cTpenka BneBo) n kHonka MENU. Haxkumaem MENU, nepexogmm K
cnenyroLLen rnase.

6 rnaBa — Tect. OTBETHI Ha BCe BOMPOChI _ Ha oguH BONPOC BO3MOXHO

HECKOJ/IbKO BAapPMaHTOB OTBETOB.
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1)

2)

3)

4)

5)

6)

7)

8)

9)

Who bares the overall responsibility for a fire fighting operation onboard a vessel until help arrives?
1. The Chief Engineer
The First Officer

2
3.
4. The Local Harbour Master

Which of the following should be installed in areas with a high risk of fire?

1. A fire locker containing protective clothing.
A PA system.

2
3.
4. A fire pump.

Which of the following should not be done when fighting a fire?
1. Cooling down bulkheads.

2.

3. Removing gas bottles from the area.
4. Shutting down electrical power.

It is important that messages to smoke divers are made:
1. through hand signals in noisy environments.

2. before they enter the fire zone.

3. on VHF ch. 06.
4.

What is the first thing that should be done upon detecting a fire?
1. Send a distress call.
Meet up at your muster station.

2
3.
4. Initiate the fixed fire fighting systems.

In the event of a fire involving dangerous goods onboard, where can you find information on the
chemical reactions taking place?

1. On stickers placed on the cargo's container.

2. Inthe cargo manifest.
3. Inthe hazardous materials catalogue.
4

Which extinguishing agent must you absolutely not use in the event of a fire involving magnesium?
1. Powder

2. Halon
3. CO2
4. Water

When discovering an injured person what is the first thing you should check for?
1.

2. Their pulse

3. Their breathing

4. For broken bones

Dry distillation can cause which of the following?
1. Structural failure

2. Flash burns

3. Breathing equipment failure

4
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10) Which of the following must smoke divers be equipped with?
1. First Aid kit

2. UHF radio

3. Heat measuring monitors
4. Infra-red viewing equipment

11) Which of the following will the local authorities take care of?

1. Requisitioning the necessary resources.

2. Contacting the company's main office.
3. Informing the media.

12) What is the first phase of onboard fire fighting tactics?

1. Extinguish
2. Evaluate
3. Rescue

4. [Niert

13) If someone does not report to their mustering station during a fire what should be done?

L. Conducta search.

2. Advise the fire fighting teams to keep an eye out for them but continue extinguishing

operations.

3. Use the PA system to ask them to report to their mustering station.

4. Find someone to take over their duties at that station.

14) Who will usually carry out statutory surveys and certifications?

1. The ships company inspectors.
2. The ships home port authorities.
3. The IMO.

4. The ship's classification society.

15) What is the safest and most effective way to apply water in a fire fighting operation onboard a

vessel?

1. [Fog

2. Direct spray
3. Sprinkle

4. Flooding

16) One litre of water equals approximately how many litres of steam or mist?

1. 1200
2. 1400
3 1700
4. 1900

17) What should fire-fighters always be equipped with?
1.
2. Reflective metallic suits
3. Axes
4. GMDSS

18) What is the most common cause of engine room fires?
1. Overload on the engine.
2. Cigarettes coming in contact with flammable waste.
3. Faulty electrical equipment.
4.

154



19) What kind of fires should be reported?
1. Any fire involving damage to equipment.
2. Any fires involving death or injury.
3. Large fires requiring aid from local authorities.
4.

20) In the event of a fire investigation what should the crew do?

1. Aid inthe collection of evidence.

2. Make sure all equipment that was used is put back in the proper place.
3. Clean away debris from the site.

4. Make sure that any problem that could have caused the fire is already fixed.

21) Why is it important to report fires?
1. Itis needed for insurance claims.
2. ltisrequired by the IMO.
3.
4. Local fire authorities involved in the operation require it.

22) When writing a report, which one of the following questions should be asked when interviewing

witnesses?

1. Were proper routines followed.
2. Was equipment working properly.
3. Was the area well maintained.
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